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Point of Sale 

Holds and Quotes with Authorized Transactions Disallowed 
Counterpoint no longer allows a ticket to be placed on hold or converted into a quote if the ticket includes an authorized debit payment, 
EBT payment, or Moneris refund. If you attempt to place a ticket with an authorized debit payment, EBT payment, or Moneris refund on hold or 
convert it into a quote, an error message appears, alerting you that you cannot save the ticket as a quote or a hold. 

 

Restricting Manual Entry of Weight 
To comply with Canadian regulations, NCR Counterpoint now allows you to prevent the manual entry of weighed items if an electronic scale is 
available. In addition, manually weighed items can now be indicated on receipts, along with the per-unit price for weighed items. 

To restrict the manual entry of weight for weighed items in Ticket Entry or Touchscreen Ticket Entry, select the Restrict manual entry of 
weight check box on the Tickets-1 tab of the Stores window (Setup > Point of Sale > Stores). 

 
With this setting, if a scale is defined for a workstation on the Device Management window (Setup > Point of Sale > Devices) and 
Counterpoint is able to obtain a weight from the scale, users will be unable to entry weight manually on the Waiting for scale... dialog. 
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If Counterpoint is unable to obtain a weight from the scale, or if no scale is defined for a workstation, users will be allowed to enter weight 
manually. However, items that are weighed manually will be identified on receipts by the ***MAN WT indicator, along with the per-unit price of 
all weighed items, regardless of whether they were weighed manually. 
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Rounding for Minimum Currency Denominations 
NCR Counterpoint now allows you to specify a minimum denomination for each form of currency you accept and automatically round payment 
and change amounts to the minimum denomination, based on the rounding method you specify. This enhancement allows you to comply with 
currency regulations in countries that have eliminated pennies or other small denominations, including Canada, Australia, Mexico, and New 
Zealand. 

Before you can use this feature, you must update the relevant currency code and pay code for each currency you accept. Once you have 
configured the necessary settings, Counterpoint will automatically round payments and change in Ticket Entry and Touchscreen Ticket 
Entry. 

Configuring Currency Codes 
The Currency Codes window (Setup > System > Currency Codes) allows you to specify the smallest denomination for each currency you 
accept, along with the rounding method for the currency and the account to use for any gains and losses that result from currency rounding. 

 
Enter the Minimum denomination for each currency you want to round (including your HOME currency, if applicable). For example, for 
Canadian currency, you should enter 0.05 in this field to specify that nickels are the smallest valid denomination. 

 The default value for the Minimum denomination field is 0.01. 

Select one of the following options for the currency from the Currency rounding method list box: 

• The Up option rounds the currency up to the next higher increment of the specified Minimum denomination. For example, if the 
Minimum denomination is 0.05 and the Change due for a ticket is 1.22, Counterpoint will round the change up to 1.25. 

• The Down option rounds the currency down to the next lower increment of the specified Minimum denomination. For example, if the 
Minimum denomination is 0.05 and the Change due for a ticket is 1.24, Counterpoint will round the change down to 1.20. 

• The Normal option rounds the currency (up or down) to the nearest increment of the specified Minimum denomination. 

 If you updated to NCR Counterpoint V8.5 from V8.4.6.11 or earlier, the Currency rounding method value will be set to Down by default. 
Make sure you select the appropriate option for this setting. 

When a payment is rounded in Ticket Entry or Touchscreen Ticket Entry, Counterpoint creates an accounting distribution for the difference 
between the calculated Amount due and the rounded amount the customer actually paid. Similarly, when change is rounded, Counterpoint 
creates a distribution for the difference between the calculated Change due and the rounded amount of change that was refunded to the 
customer. These distributions are posted to the Currency rounding account you specify, using the Profit center method you select. 

 The Currency rounding account fields are not available if the Minimum denomination value is 0.01. 
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Configuring Pay Codes 
For each currency you are rounding, specify whether you accept payments or issue change in denominations smaller than the Minimum 
denomination for the corresponding pay code on the Tender tab of the Pay Codes window (Setup > System > Pay Codes). 

 
Select the Allow tender below minimum currency check box to allow users to accept payments in denominations smaller than the 
Minimum denomination defined for the currency. 

Select the Allow change/refund below minimum currency check box to allow users to issue change in denominations smaller than the 
Minimum denomination defined for the currency. 

Make sure you have assigned the pay codes that correspond to each currency code you are rounding to each of your stores using the Pay 
Codes button on the Stores window (Setup > Point of Sale > Stores). 
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Selecting Multiple Documents for Pay-on-account Transactions 
If you have the Receivables Option, you can enter pay-on-account transactions in Ticket Entry and Touchscreen Ticket Entry to record 
payments for your A/R customers directly, without requiring you to use the Cash Receipts Enter window (Customers > Cash Receipts > 
Enter). Previously, however, you have only been able to apply a particular payment to a single open ticket or other A/R document. In this 
version of NCR Counterpoint, you can select multiple documents for a pay-on-account transaction, allowing you to apply a single payment to 
more than one ticket or order. 

 Only authorized users can enter pay-on-account transactions. To authorize users to enter pay-on-account transactions, select the Use pay-
on-accounts check box on the Tickets tab of the Point of Sale Security Codes window (Setup > Point of Sale > Security Codes). 

Follow these steps to apply a pay-on-account transaction to multiple documents; 

1. If you are using Ticket Entry, select Special > Pay-on-account from the Additional functions menu to display the Pay-on-account 
dialog. 

If you are using Touchscreen Ticket Entry, touch the Pay On Account button in your touchscreen layout to display the Pay-on-
account dialog.  

2. Enter or look up the Customer # for the customer for whom you are recording the payment. 

3. Select Multiple from the Apply-to method list box to indicate that you want to select multiple documents for the pay-on-account 
transaction. 

 
When you select this option, all open documents for the selected customer appear, allowing you to choose more than one document 
for the pay-on-account transaction. 

 

4. Enter or look up the Pay code for the payment. 

5. Enter the total Amount for the payment or select the Calculate pay amount from apply-to lines check box to have Counterpoint 
automatically add the amount you apply to each document to determine the total payment amount. 
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6. Enter the amount to apply to each open document in the Amount column of the apply-to lines table, or click the  Pay 
Balance button to pay the entire balance for the document. 

 If paying the entire balance of a document would exceed the total Amount you specified for the payment, clicking the  Pay Balance 
button applies the remaining amount of the payment to the document instead. 

As you apply the payment to open documents, the Amount applied to document(s) field displays the total amount of the payment 
that has been applied.  

• If you specified an overall Amount for the payment, the Apply excess to (open) field displays the amount of the payment that has 
not been applied. When you save the pay-on-account transaction, this amount will be left open (i.e., unapplied). If the entire payment 
has been applied, the Amount remaining to apply field displays 0.00. 

• If you selected the Calculate pay amount from apply-to lines check box, the total Amount of the payment is automatically updated 
as you specify the Amount to apply to each document (or click the corresponding  Pay Balance button) and the Apply 
excess to (open) field is set to 0.00. You can enter an amount in the Apply excess to (open) field to specify a portion of the 
payment to leave unapplied, which is added to the total Amount of the payment. 

7. When you have specified the amount of the payment to apply to each open document, click OK to complete the pay-on-account 
transaction. 

Selling Weighed Items with Random Weight Barcodes 
When you scan a random weight barcode that is assigned to a Weighed item in Ticket Entry or Touchscreen Ticket Entry, the Enter 
Weight dialog does not appear. Instead, the quantity (i.e., weight) and extended price for the item are derived from the random weight 
barcode. 

 Previously, if you scanned a random weight barcode assigned to a Weighed item, the Enter Weight dialog always appeared, requiring the 
user to dismiss the dialog to proceed with the ticket. 
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Tax Jurisdiction Totals in Ticket Entry 
Certain countries require merchants to disclose the specific amount of tax that is being collected by each tax authority or tax jurisdiction for 
each item sold. For example, in most Canadian provinces, you must indicate the amount of Provincial Sales Tax (PST) and Goods and 
Services Tax (GST) that applies to each item. To comply with these requirements, NCR Counterpoint now allows you to display the amount of 
tax collected by each tax authority or tax jurisdiction for each item sold in Ticket Entry and Touchscreen Ticket Entry. 

To automatically display tax authority or tax jurisdiction totals in Ticket Entry or Touchscreen Ticket Entry, select the Show tax authorities 
check box on the Main tab of the Stores window (Setup > Point of Sale > Stores) for each of your stores. 

 
With this setting, when a user adds an item to a ticket in Ticket Entry or Touchscreen Ticket Entry, the Document Totals area automatically 
displays the amount of tax being collected by each tax authority or tax jurisdiction for the item directly above the total amount of Tax for the 
item. 

  

© 2015 NCR, All rights reserved March 2015 7  



NCR Counterpoint  V8.5 Release Notes 

Voiding Tickets with Authorized Debit Transactions 
Previously, Counterpoint did not allow tickets with one or more authorized debit payments to be voided, as authorized debit payments cannot 
be reversed. In this version, however, you can void an active (i.e., uncompleted) ticket that includes an authorized debit payment and issue a 
refund for the debit payment. 

 Completed tickets with authorized debit transactions still cannot be voided. 

When you click or touch the Void button in Ticket Entry or Touchscreen Ticket Entry, if the current ticket includes an authorized debit 
transaction, a message appears, alerting you that the authorized debit payment(s) on the ticket must be refunded. 

 
If you click Yes, Counterpoint removes all lines from the ticket, along with all payments except the authorized debit payment(s). Counterpoint 
then automatically creates a Change/Refund payment for the amount of the authorized debit payment(s), using the Default change pay 
code defined on the Stations window (Setup > Point of Sale > Stations) for your station. 

 If a Default change pay code is not defined for your station, you are prompted to select a pay code for the refund. 

The ticket is not completed automatically, allowing you to review the Change/Refund amount and pay code. When you are satisfied that they 
are correct, you can complete the ticket and issue the refund for the authorized debit payment(s) to the customer. 

 Voiding a ticket with an authorized debit payment creates a ticket with payments only. Before completing such a ticket, you may want to add a 
note to the ticket to explain why the ticket was voided. 
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Inventory 

Calculating and Displaying Tax-inclusive Prices 
In this version, you can configure NCR Counterpoint to calculate and display price values that include tax. In addition, the Set Price dialog 
now allows you to specify tax-inclusive prices for your items, which will appear in Ticket Entry and Touchscreen Ticket Entry, on customer 
displays and line displays, and on customer receipts. This feature supports merchants who are required to present tax-inclusive prices to 
customers. 

 This enhancement only affects how prices are presented on screen in Ticket Entry and Touchscreen Ticket Entry, on line displays and 
customer displays, and on receipts and reports. Tax-inclusive price values are not stored in the Counterpoint database or otherwise tracked. 
Further, because Counterpoint determines tax-inclusive values by adding pre-tax prices and the applicable tax amounts, rounding errors can 
prevent Counterpoint from calculating a specific tax-inclusive price, particularly as quantities on ticket lines increase. To minimize rounding 
errors in tax-inclusive price calculations, you should set the Price decimals value for your items to 4, avoid using multiple tax authorities in 
your tax codes, and enable the Use consolidated lines setting for your stations. 

Configuring Counterpoint to Display Tax-inclusive Prices 

Defining Tax-inclusive Prices 

Printing Labels with Tax-inclusive Prices 

Selling Items with Tax-inclusive Prices 
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Configuring Counterpoint to Display Tax-Inclusive Prices 
This topic details the process of configuring NCR Counterpoint to calculate and display tax-inclusive prices. 

Designating Tax-inclusive Stores 
Follow these steps to designate your store(s) as tax-inclusive store(s): 

1. On the Counterpoint main menu, select Setup > Point of Sale > Stores to display the Stores window. 

2. Enter or look up a Store you want to designate as a tax-inclusive store. 

3. In the Taxes area of the Main tab, select the Tax-inclusive store check box to indicate that you want to calculate and display tax-
inclusive prices in the selected store. 

 

4. Click the  button to save your changes. 

 Repeat steps 2 through 4 for each of your stores. 
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Customizing Ticket Entry Columns 
Follow these steps to configure Counterpoint to display tax-inclusive prices to your users as they ring up items in Ticket Entry or 
Touchscreen Ticket Entry: 

1. From the Counterpoint main menu, start Ticket Entry or Touchscreen Ticket Entry and log in to your Store, Station, and Drawer. 
2. Right-click a column header in the line item entry area and select Column designer to display the Column designer dialog. 

 

3. In the Visible columns list, select the Gross line item price, Line item price, and Price columns and click the < Remove button. 

 If you have already customized the column layout of the line item entry area of Ticket Entry or Touchscreen Ticket Entry, some or all of 
these columns may already have been removed from the Visible columns list. 

4. In the Hidden columns list, select the Gross line item price (T), Line item price (T), and Price (T) columns and click the Add > 
button to move these columns to the Visible columns list. 

 
 You may also add the Tax amount (allocated) column to the Visible columns list to allow users to see the tax portion of each line's price. 

5. Use the Move Up and Move Down buttons to arrange the Visible columns in the order you prefer. 

6. Click OK to save your changes and return to Ticket Entry or Touchscreen Ticket Entry, where the new columns appear in the line 
item entry area. 
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7. Right-click a column header, select Save as to display the Save to Database dialog. 

 If you cannot select the Save as option, make sure the Enable customizations check box is selected on the User Interface tab of the User 
Preferences window (Setup > System > User Preferences). 

8. Enter a Save name for the new column layout and click OK. 

 

9. Close Ticket Entry or Touchscreen Ticket Entry. 

 On each of your other workstations, right-click a column header in Ticket Entry or Touchscreen Ticket Entry, select Load, and double-click 
your saved column set to display tax-inclusive prices on that workstation. 
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Customizing Line Display Messages 
If you are using line displays with your workstations, follow these steps to configure your line displays to present tax-inclusive prices to your 
customers: 

1. From the Counterpoint main menu, select Setup > Point of Sale > Devices to display the Device Management window. 

2. In the Stores and Workstations tree, double-click your store to display the workstations assigned to the store. 

3. Double-click a workstation to which a line display is connected, click the line display device entry, and then click the Configure 
Message Sets button to display the Line Display Message Sets dialog. 

 

4. Look up your message set and select the LINE event from the Events list. 

5. Click the message box that displays the line price and select TicketEntryLine._PRC_WITH_TAX from the Field list box. 

 If you are using a field other than TicketEntryLine.PRC for your line display, look for the matching _WITH_TAX option in the Field list box. 
For example, if you are using the TicketEntryLine.DISCNTED_DISP_EXT_PRC field for the LINE event, select the 
TicketEntryLine._DISCNTD_DISP_EXT_PRC_WITH_TAX field to display the tax-inclusive value. Each _WITH_TAX field begins with an 
underscore character (_). 

6. Select the VOID event from the Events list. 

7. Click the message box that displays the voided line price and select the appropriate _WITH_TAX option from the Field list box (e.g., 
TicketEntryLine._PRC_WITH_TAX (_PRC_WITH_TAX). 

8. Click the  button to save your changes, and then close the Line Display Message Sets dialog. 

 Repeat steps 3 through 8 for each workstation with a line display. 

9. Click Save & Close to save your device settings and close the Device Management window. 
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Customizing Customer Display Columns 
If you are using customer displays with your workstations, follow these steps to configure your customer displays to present tax-inclusive 
prices to your customers: 

1. From the Counterpoint main menu, select Setup > Point of Sale > Devices to display the Device Management window. 

2. In the Stores and Workstations tree, double-click your store to display the workstations assigned to the store. 

3. Double-click a workstation to which a customer display is connected, click the Customer Display device, and then click the 
Configure Display button. 

4. Right-click a column header in the Line Item Grid Panel dialog and select Column designer to display the Column designer dialog. 

5. Replace the T, Price, and Ext prc columns with the Gross line item price (T), and Line item price (T) columns. 

 If you have already customized your customer display layout, some of all of these columns may have already been replaced. You may also 
wish to include the Tax amount (allocated) column to allow customers to see the tax portion of each line's price. 

6. Click OK on the Customer Display dialog to save your changes and return to the Device Management window. 

 Repeat steps 3 through 6 for each workstation with a customer display. 

7. Click Save & Close to save your device settings and close the Device Management window. 

Customizing Receipts 
Follow these steps to customize .rdlc receipts to print tax-inclusive prices for each line item: 

1. From the Counterpoint main menu, select Setup > Point of Sale > Form Groups to display the Form Groups window. 

2. Enter or look up the Form group that includes your receipt form (e.g., TICKET). 

3. Select the Forms tab, select your receipt form (e.g., Receipt1.rdlc), and click the Form Editor button to display the Receipt Designer 
window. 
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If you have not customized your receipt form, a message appears, prompting you to confirm that you want to create a new custom 
form. Click Yes to continue. 

 

4. In the Items band of the receipt layout, select the Expression text box for the item Price value. 

 

5. In the Control properties area, click the Value field under Textbox, and then click the  button to display the Edit Expression dialog. 

 

6. Replace the existing expression with the following expression: 

=Format(Iif(Fields!QuantitySold.Value = 0, Fields!Price.Value + Fields!TaxAmountAllocation.Value, 
Fields!Price.Value + (Fields!TaxAmountAllocation.Value / Fields!QuantitySold.Value)), "#,##0.00") 

 This expression adds theTaxAmountAllocation value for the line divided by the quantity of the item sold to the item's Price value to print the 
tax-inclusive unit price for each item on the receipt. You may need to revise this expression to meet your particular needs. 

7. Click OK to save your changes and close the Edit Expression dialog. 

8. In the Items band, select the Expression text box for the Total value. 

 

9. In the Control properties area, click the Value field under Textbox, and then click the  button to display the Edit Expression 
dialog. 
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10. Replace the existing expression with the following expression: 

=Iif(Convert.ToString(Fields!LineType.Value)="Unshipped", "Unshipped", 
Format(Max(Fields!GrossDisplayExtendedPrice.Value + Fields!TaxAmountAllocation),"#,##0.00")) 

 This expression adds the TaxAmountAllocation value for the line to the GrossDisplayExtendedPrice value for the line to print the tax-
inclusive price for the line on the receipt. 

11. Click OK to save your changes and close the Edit Expression dialog. 

12. In the Totals band, select the Expression text box for the Subtotal value, click the Value field under Textbox in the Control 
properties area, and then click the  button to display the Edit Expression dialog. 

13. Replace the existing expression with the following expression and click OK. 

=Format(Fields!GrossDiscSubTotal.Value + Fields!TotalTax.Value,"#,##0.00") 

 This expression adds the TotalTax value for all lines on the ticket to the GrossDiscSubTotal value for the ticket to print the tax-inclusive 
subtotal on the receipt. 

14. Select File > Save to save your changes, and then close the Receipt Designer window. 

15. Click the  button on the Form Groups window to save your form group. 

 To comply with legal requirements that apply to your company, you may need to modify other fields on your receipt form. 

Customizing Reports 
You can customize reports that include item prices to display tax-inclusive prices by adding the per-unit tax amount to the unit price of each 
item. In particular, you may wish to update the following reports to display tax-inclusive prices: 

• ITEM PRICE LIST (Inventory > Reports > Item Price List) 

• ITEM PRICE-1 LIST (Inventory > Reports > Item Price-1 List) 

• PRICES (Inventory > Reports > Prices) 

• CUSTOMER PRICE LIST (Inventory > Reports > Customer Price List) 

• GIFT REGISTRY REPORTS (Point of Sale > Gift Registries > Gift Registry Reports) 
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Defining Tax-inclusive Prices 
Once you have configured Counterpoint to calculate and display tax-inclusive prices, use the Set Price dialog—which you can access by 
clicking the margin button ( , , or ) next to a price field—to define tax-inclusive prices for your items. 

 
You can specify tax-inclusive values for prices throughout Counterpoint. For example: 

• On the Items window (Inventory > Items), you can define tax-inclusive values for the Price-1 and Regular price fields on the Main 
tab, as well as for alternate unit price fields on the Units tab. 

• On the Item Prices window (Inventory > Prices > Item Prices), you can define tax-inclusive values for Price-1 through Price-3 (or 
through Price-6, if you are using the Advanced Pricing Option) fields on the Stocking Prices tab and on each alternate unit tab. 

• On the Price Sheet window (Inventory > Prices > Price Sheet), you can define tax-inclusive values for Price-1 through Price-6 
fields. 

 On the Price Sheet window, only the Price-1 through Price-6 fields include the margin button; other price fields do not. 

 Although you can specify tax-inclusive price values for your items, price fields throughout Counterpoint will still display pre-tax price values for 
your items. When you sell an item in Ticket Entry or Toucshcreen Ticket Entry, Counterpoint will add the appropriate amount of tax to the 
pre-tax price to derive the tax-inclusive price, which will appear on screen, on your line display or customer display, and on the customer's 
receipt. 

© 2015 NCR, All rights reserved March 2015 17  



NCR Counterpoint  V8.5 Release Notes 
Follow these steps to specify tax-inclusive Price-1 values for your items: 

1. From the main menu, select Inventory > Items to display the Items window. 

 You can also specify tax-inclusive Price-1 values on the Item Prices window (Inventory > Prices > Item Prices). 

2. Enter or look up the Item number for the item you are modifying. 

3. Select the Other tab and make sure the Price decimals field is set to 4 for the item. If it isn't, click the  button to allow protected 
changes and change the Price decimals value to 4. 

 

 This setting helps ensure that Counterpoint can display tax-inclusive price for multiple quantities more accurately. 

4. Select the Main tab, and click the  button next to the Price-1 field to display the Set Price dialog. 

 

5. Enter or look up the tax code that applies to the item in the Include tax for field. This tax code determines how Counterpoint will 
calculate the pre-tax price for the item, based on the tax-inclusive price you specify for the item. 

 By default, this field is set to the tax code that is defined for your store in the Store tax code field on the Main tab of the Stores window 
(Setup > Point of Sale > Stores). 

6. Enter the tax-inclusive price for the item in the New price field.  
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Counterpoint automatically calculates and displays the pre-tax price and the normal tax amount for the item to the right of the New 
price field, based on the tax code specified in the Include tax for field. 

The Rounded price field displays the tax-inclusive price after the specified Rounding rule has been applied, which may differ from 
the New price value you specified. 

 If the tax-inclusive price cannot be represented exactly (due to the tax rules in effect, the Rounding method for the applicable tax rules, or the 
Price decimals setting for the item), the pre-tax price plus the tax amount that Counterpoint calculates for the item is displayed in red. This 
Total is as close as Counterpoint can get to the tax-inclusive price you specified, under the applicable tax rules. 

 

7. Click OK to save your changes and close the Set Price dialog. The Price-1 value for the item is set to the pre-tax price automatically. 

 
When you sell the item in Ticket Entry or Toucshcreen Ticket Entry, Counterpoint will add the appropriate amount of tax to the pre-
tax price to derive the tax-inclusive price you specified for the item. 

8. Click the  button to save your changes. 

 Repeat these steps for each of your items.  

You can also use the Set Price dialog to specify a tax-inclusive value for the Regular price field on the Main tab of the Items window.. If you 
are using unit-specific prices, you can specify a tax-inclusive Price-1 value for each alternate unit on the Units tab. To specify tax-inclusive 
values for Price-2 through Price-6 fields, use the Item Prices window (Inventory > Prices > Item Prices). 
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Printing Labels with Tax-inclusive Prices 
Once you have defined tax-inclusive prices for your items, you can print labels that include tax-inclusive prices. 

To print labels with tax-inclusive prices, you can use the Labels from Tags window (Inventory > Labels from Tags) or the Item Labels 
window (Inventory > Item Labels), both of which now include the Tax code field. 

 

 The Tax code field appears only if you have selected the Tax-inclusive store check box on the Main tab of the Stores window (Setup 
> Point of Sale > Stores). 

Enter or look up the Tax code that applies to the items for which you are printing labels. 

 By default, this field is set to the tax code that is defined for your store in the Store tax code field on the Main tab of the Stores window 
(Setup > Point of Sale > Stores). 

When you print item labels with the appropriate Tax code specified, the tax-inclusive price appears on the label for each item.. 

 
 If you do not specify a Tax code (by clearing the default value), the pre-tax price will appear on the label for each item. 

© 2015 NCR, All rights reserved March 2015 20  



NCR Counterpoint  V8.5 Release Notes 

Selling Items with Tax-inclusive Prices 
Once you have configured Counterpoint to display tax-inclusive prices and defined tax-inclusive prices for your items, Counterpoint 
automatically adds the appropriate amount of tax to each item's pre-tax price to display tax-inclusive prices in Ticket Entry or Touchscreen 
Ticket Entry. 

 
 The Price and Net line price fields on the Ticket Entry window indicate the pre-tax price for each item. 

 Counterpoint allocates the total amount of tax for all items on the ticket to each line proportionally to calculate the tax-inclusive price for each 
line. As you add lines to a ticket, the tax-inclusive values displayed in the line item entry area of Ticket Entry or Touchscreen Ticket Entry 
may change to reflect the current tax allocation. If these values drift from the tax-inclusive prices you intended, you may need to adjust your 
tax rules, change the Rounding method assigned to your tax rules, or modify the Price decimals value for your items. 

If you sell an item for which the Prompt for price check box has been selected on the Other tab of the Items window (Inventory > Items), the 
Enter price dialog allows you to specify a tax-inclusive Price for the item, indicating the pre-tax price and the per-unit tax amount to the right of 
the Price field. 
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Also, If you override an item's price in Ticket Entry (using the Line > Change price function) or Toucshcreen Ticket Entry (using the Price 
override or Price override percent button), the Price override dialog allows you to specify a tax-inclusive Price for the item. 

 
When you complete a ticket, your custom receipt will indicate that tax-inclusive Price and tax-inclusive Total for each line. 
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Customers 

Multiple Cards on File per Customer 
This version of NCR Counterpoint allows you to store multiple credit cards for each customer and choose which one to use when you process 
a payment, deposit, pay-on-account transaction, or refund for the customer in Ticket Entry or Touchscreen Ticket Entry. 

Assigning Credit Cards to a Customer 
Follow these steps to assign one or more credit cards to a customer: 

1. Select Customers > Customers to display the Customers window. 

2. Enter or look up the Customer # for the customer to whom you want to assign a credit card, or create a new customer record for the 
customer. 

3. Select the Payment tab. 

4. In the Credit Cards area, click the Add button to create a new credit card entry for the customer. 

 

5. Enter a Card description for the credit card (e.g., Visa or Primary), along with the Credit card #,Credit card exp date, and 
Cardholder's name. 

 When you enter a Credit card # value, it is immediately masked. The unmasked card number will not be visible again. If you need to edit the 
Credit card #, you must reenter the entire value. 

6. Enter or look up the Pay code to associate with the credit card. The image associated with the pay code you select appears next to 
the credit card entry in the Credit Cards table. 

7. Select the Default check box if you want to indicate that the credit card is the one that the customer typically uses. The default credit 
card entry appears in bold in the Credit Cards table. 

 Repeat steps 4 through 7 for each credit card you want to assign to the customer. 

8. Click the  button to save your changes. 

 To remove a credit card from a customer record, select the credit card entry in the Credit Cards table and click the Delete button. To change 
the position of a credit card entry in the Credit Cards table, select the credit card entry and click Move up or Move down. 
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Selecting a Customer Card 
In Ticket Entry, when you click the Use Customer Card button on the Payment Entry dialog or the Pay-on-account dialog, if the specified 
customer has multiple credit cards on file, the Select Customer Card dialog appears, allowing you to choose the card on file to use for a 
payment, deposit, or refund. 

 In Touchscreen Ticket Entry, this dialog appears when you touch the Pay with customer card on file button or Pay on account button in 
your touchscreen layout. 

This dialog also appears when you click the Use Customer Card button on the Order Cancel, Order Deposit Refund, Layaway Cancel, or 
Layaway Deposit Refund dialogs in Ticket Entry or Touchscreen Ticket Entry. 

 
 The credit card that is designated as the Default card on file for the customer is highlighted on this dialog. 

Click a button on the Select Customer Card dialog to select the customer card to use for the payment, deposit, or refund and proceed to the 
Validations dialog to complete the transaction. 
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Purchasing 

Multi-currency Purchasing 
NCR Counterpoint allows you to create multiple currency codes, allowing you to sell merchandise in "foreign" currencies that are different from 
your default, or "home," currency. In previous versions, however, multi-currency support was limited to Point of Sale operations. In this 
version, NCR Counterpoint allows you to purchase merchandise from your vendors in different currencies. 

This enhancement allows a merchant that typically works in one currency to more easily order merchandise from a vendor that uses a different 
currency. For example, if you typically sell items in U.S. dollars, but you order merchandise from vendors who use Euros, Pesos, Canadian 
dollars, or another currency, this feature allows you to work with those vendors in their native currencies. 

 If you only purchase items from vendors that use the same currency you do, you do not need to enable this feature. 

Once you have configured multi-currency purchasing, you will be able to process purchase requests, receivers, purchasing adjustments, and 
returns to vendors (RTVs) in multiple currencies. If you have configured Counterpoint to interface with your accounting software, you will also 
be able to voucher receivers that were originally created in a foreign currency, automatically converting invoice amounts to your home 
currency. 

 You cannot process quick receivings (Purchasing > Quick Receivings > Enter) in foreign currencies. 

Configuring Multi-currency Purchasing 

Purchase Requests 

Receivings 

Purchasing Adjustments 

Returns to Vendors 

Vouchering Receivings 
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Configuring Multi-currency Purchasing 
This topic details the process of configuring NCR Counterpoint to support multi-currency purchasing, allowing you to purchase merchandise 
from your vendors in foreign currencies. 

Enabling Multi-currency Purchasing 
First, select the Use multi-currency check box on the Main tab of the Purchasing Control window (Setup > Purchasing > Control). This 
setting enables Counterpoint to track and display item costs in the currencies used by your vendors. 

 
 To disable multi-currency purchasing, clear the Use multi-currency check box. When you clear this check box, a message appears, alerting 

you that existing multi-currency purchasing data will not be removed. This means that the cost values on any Purchasing documents you have 
already created in foreign currencies will not be automatically converted into your home currency. 

 

Defining Currency Codes 
Next, use the Currency Codes window (Setup > System > Currency Codes) to define a currency code for each foreign currency your 
vendors use. 

 

 If you have already defined currency codes for use in Point of Sale, those currency codes will be available for use in Purchasing. 

Enter a Currency code and Description for the currency you are defining. We recommend using standard, three-character ISO 4217 
Currency code values. 
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You may also enter a Short description that will identify the currency in purchasing-related areas of Counterpoint. This value can be different 
from the Currency code value, helping you to identify the currency more easily on screen. 

 If you do not specify a Short description for a currency code, Counterpoint will display the Currency code value for the currency. 

Each currency code must include one or more exchange rates for the currency. An exchange rate specifies the number of units of the foreign 
currency that is equivalent to a number of units of your home currency. For example, if your home currency is U.S. dollars (USD), the current 
exchange rate for Canadian dollars (CAD) might be 1.2538 CAD to 1.000 USD. 

 

You can define two different exchange rates for each currency code, allowing you to maintain separate exchange rates for Point of Sale 
transactions and Purchasing documents: 

• The Default exchange rate is always used for Point of Sale transactions, as well as for Purchasing documents if you have not defined 
a Purchasing exchange rate.  

• The Purchasing exchange rate, if you define one, is used for Purchasing documents only. 

 Each exchange rate field allows you to enter up to four digits after the decimal point. 

 You should periodically update the exchange rate(s) for each currency to ensure that you are using accurate values. The frequency with which 
you should update exchange rates depends on how often you purchase items in foreign currencies. Also, bear in mind that exchange rate 
fluctuations may affect financial reporting, requiring you to make G/L entries whenever an exchange rate changes. Consult your accountant for 
specific advice regarding exchange rate requirements. 

If you are using rounding for minimum currency denominations, specify the Minimum denomination value, Currency rounding method, and 
Currency rounding account for the currency. 

You must also specify a Purchasing gain/loss account for the currency (and the corresponding Profit center, if you are using profit centers) to 
track distributions for any amounts gained or lost due to the conversion of foreign currency into your home currency on Purchasing 
documents. 

 
The Purchasing gain/loss account may be the same account as the Gain/loss account, which is used to track gains and losses due to 
currency conversion on Point of Sale documents, or it may be a different account, if you want to track gains and losses on Purchasing 
documents separately. 

Finally, you may wish to define currency units for each denomination (i.e., bills and coins) of currency you accept for Point of Sale 
transactions. Refer to the Simplified cash counting topic in the NCR Counterpoint online help for more information about setting up currency 
units. 
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Assigning Default Currency Codes to Vendors 
Once you have defined currency codes for your vendors, you may assign a Default currency code to each vendor on the Main tab of the 
Vendors window (Purchasing > Vendors). 

 
The currency code you assign to a vendor will be used by default on all Purchasing documents for that vendor, although you can change the 
currency code assigned to a particular Purchasing document when you create it. 

Assigning Default Currency Codes to Miscellaneous Charges 
Once you have assigned currency codes to your vendors, you may also wish to assign a Default currency to each miscellaneous charge on 
the Misc charges tab of the Purchasing Control window (Setup > Purchasing > Control). 

 
The currency you assign to each miscellaneous charge will be used by default on all Purchasing documents, even if it is different from the 
currency code assigned to the vendor for each document. This allows you to track freight or other miscellaneous charges in different 
currencies, which is particularly useful if you rely on third-party shipping companies to deliver merchandise from your vendors. 

 If you do not assign a Default currency to a miscellaneous charge, the miscellaneous charge will use the currency code assigned to the 
vendor on each Purchasing document by default. 
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Review Costs for Vendor Items 
When you assign default currency codes to your vendors, you may wish to review your vendor item records to ensure that their costs are 
accurate. On the Purchasing tab of the Vendors Items window (Purchasing > Vendor Items), make sure the Unit cost value for each 
vendor item record is correct for the vendor's default currency. 

 
You can choose to display costs on the Vendor Items window in your home currency or in the default currency assigned to the vendor by 
selecting Home currency or Vendor currency from the Show costs in... area. 
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Configuring the Accounting Interface 
If you are using NCR Counterpoint to voucher receivers (and RTVs) to your accounts payable software, you must also configure your 
accounting interface to support multiple currencies. Specify a Gain/loss account (along with the corresponding profit center, if you are using 
profit centers) on the Accounts Payable tab of the Accounting Interface window (Setup > System > Accounting Interface). 

 
The Gain/loss account tracks distributions for amounts that are gained or lost due to the conversion of foreign currency into your home 
currency. This account should be the same account you specified as the Purchasing gain/loss account for your currency codes, as outlined 
under Defining Currency Codes, above. 
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Multi-currency Purchasing: Purchase Requests 
If multi-currency purchasing is enabled for your company, you can process purchase requests in currencies other than your home currency. 
This topic details the changes you will see on the Purchase Requests Enter window (Purchasing > Purchase Requests > Enter) when you 
are using multi-currency purchasing. 

By default, cost values on the Purchase Requests Enter window appear in the Document currency, which is determined by the Currency 
code assigned to the purchase request. You can view costs in your home currency by selecting the Home currency option from the Show 
costs in... area. However, if you select this option, you will not be able to edit Gross unit cost values for items on the Lines tab or Amount 
values for miscellaneous charges on the Misc charges tab. 

 
 This setting only affects how cost values are displayed on the Purchase Requests Enter window. The Currency code assigned to a 

purchase request determines the currency that will be used for the distributions that are created when you post the purchase request. 

Vendor Tab 
When you enter or look up a Vendor number for a purchase request on the Vendor tab of the Purchase Requests Enter window, the 
vendor's default Currency code and the current Exchange rate for that currency appear automatically. 

 
If a default currency code is not assigned to the vendor, or you want to use a different currency for the purchase request, enter or look up the 
appropriate Currency code. 

 If you change the Currency code for a purchase request, a message appears, warning you that the currency has changed and that all lines 
on the purchase request will be reset to their default cost values. 
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If you want to override the current Exchange rate for the currency assigned to the purchase request, click the Change button to display the 
Exchange Rates dialog. 

 Once you have posted a purchase request, you cannot change the exchange rate(s) for the purchase request or the resulting purchase order. 
However, you will be able to modify the exchange rate(s) when you receive the purchase order. 

Lines Tab 
On the Lines tab, when you add an item to the purchase request, you will specify the Gross unit cost for the item in the currency assigned to 
the purchase request. 

 

 You can only modify the Gross unit cost value for an item on the purchase request if the Document currency option is selected in the Show 
costs in... area. 

Any Discount amount or percentage you apply to a line on the purchase request will also be in the currency assigned to the purchase 
request. Likewise, if you apply a discount amount or percentage to the entire purchase request (by clicking the Doc Discount button and 
specifying a Discount type and Discount value on the Document discount dialog), the document discount will be in the currency assigned to 
the purchase request. 

 

 The Document discount dialog displays the discount in the assigned currency and in the equivalent amount of your home currency. 

The Add items button on the Lines tab—which allows you to add multiple items to a purchase request simultaneously—is not available if the 
Currency code on the Vendor tab is not your home currency. An error message appears if you click this button when a foreign currency is 
assigned to a purchase request. 
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Misc charges Tab 
The Misc charges tab allows you to record miscellaneous charges for a purchase request, such as the expected freight amount for the 
merchandise. If a currency code is assigned to a miscellaneous charge (in Setup > Purchasing > Control), the Misc charges tab displays 
the Currency and the corresponding Exchange rate. If a default currency is not assigned to a miscellaneous charge, the miscellaneous 
charge appears in the currency assigned to the purchase request. 

 
The Amount you enter for each miscellaneous charge is recorded in the specified Currency. You can select a different Currency if you want 
to record the miscellaneous charge in a different currency. However, the Total misc amount in the totals area of the Misc charges tab always 
displays the total amount of all miscellaneous charges in the currency assigned to the purchase request (or your home currency, if the Home 
currency option is selected in the Show costs... area). 

 You can only modify the Amount value for a miscellaneous charge if the Document currency option is selected in the Show costs in... area. 

If you want to override the current Exchange rate for the currency assigned to the miscellaneous charge, click the Exch rates button to 
display the Exchange Rates dialog. 

 Once you have posted a purchase request, you cannot change the exchange rate(s) for the purchase request or the resulting purchase order. 
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Multi-currency Purchasing: Receivings 
If multi-currency purchasing is enabled for your company, you can process receivings for merchandise—with or without a corresponding 
purchase order—in foreign currencies. This topic details the changes you will see on the Receivings Enter window (Purchasing > 
Receivings > Enter) when you are using multi-currency purchasing. 

When you select a purchase order to receive, the Select receiving mode dialog displays miscellaneous charge amounts in the currency 
assigned to the miscellaneous charge, along with the equivalent amount in your home currency, if applicable. 

 
By default, cost values on the Receivings Enter window appear in the Document currency, which is determined by the Currency code 
assigned to the receiver or the original purchase request. You can view costs in your home currency by selecting the Home currency option 
from the Show costs in... area. However, if you select this option, you will not be able to edit Gross unit cost values for items on the Lines tab 
or Amount values for miscellaneous charges on the Misc charges tab. 

 
 This setting only affects how cost values are displayed on the Receivings Enter window. The Currency code assigned to a receiver 

determines the currency that will be used for the distributions that are created when you post the receiver. 
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Receiver Tab 
If you are receiving a purchase order, the Currency code assigned to the receiver and the corresponding Exchange rate appear on the 
Receiver tab. This tab also displays the Default currency for the vendor, which may be different from the currency assigned to the receiver.  

 You cannot change the Currency code for a receiver if you are receiving a purchase order. 

 
If you are receiving without a purchase order, the default Currency code for the receiver and the corresponding Exchange rate are 
determined by the vendor you choose. If a default currency code is not assigned to the vendor, or you want to use a different currency for the 
receiver, enter or look up the appropriate Currency code to assign a currency to the receiver. 

 You cannot change the Currency code for a receiver without a purchase order if there are any lines on the receiver. 

Whether you are receiving with or without a purchase order, you can override the current Exchange rate for the currency assigned to the 
receiver by clicking the Change button and entering the new exchange rate on the Exchange Rates dialog. 

 Once you have posted a receiver, you cannot change the exchange rate(s) for the receiver. 
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Lines Tab 
On the Lines tab, you can specify the Gross unit cost for items on the receiver in the currency assigned to the receiver. 

 

 You can only modify the Gross unit cost value for an item on the receiver if the Document currency option is selected in the Show costs 
in... area. 

Any Discount amount or percentage you apply to a line on the receiver will also be in the currency assigned to the receiver. If you apply a 
discount amount or percentage to the entire receiver (by clicking the Doc Discount button and specifying a Discount type and Discount 
value on the Document discount dialog), the document discount will be in the currency assigned to the receiver. 

 

 The Document discount dialog displays the discount in the assigned currency and in the equivalent amount of your home currency. 
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Misc charges Tab 
The Misc charges tab allows you to record miscellaneous charges for a receiver, such as the actual freight amount for the order. If you are 
receiving a purchase order, the Amount and Currency for each miscellaneous charge is carried over from the purchase order. If you are 
receiving without a purchase order, the Misc charges tab displays the Currency assigned to each miscellaneous charge, along with the 
corresponding Exchange rate. If a default currency is not assigned to a miscellaneous charge, the miscellaneous charge appears in the 
currency assigned to the receiver. 

 
The Amount you enter for each miscellaneous charge is recorded in the specified Currency. You can select a different Currency if you want 
to record the miscellaneous charge in a different currency. However, the Total misc amount in the totals area of the Misc charges tab always 
displays the total of all miscellaneous charges in the currency assigned to the receiver (or the home currency, if the Home currency option is 
selected in the Show costs... area). 

 You can only modify the Amount value for a miscellaneous charge if the Document currency option is selected in the Show costs in... area. 

If you want to override the current Exchange rate for the currency assigned to the miscellaneous charge, click the Exch rates button to 
display the Exchange Rates dialog. 

 Once you have posted a receiver, you cannot change the exchange rate(s) for the receiver. 
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Multi-currency Purchasing: Purchasing Adjustments 
If multi-currency purchasing is enabled for your company, you can enter purchasing adjustments for receivers that were processed in 
currencies other than your home currency. This topic details the changes you will see on the Purchasing Adjustments Enter window 
(Purchasing > Adjustments > Enter) when you are using multi-currency purchasing. 

By default, cost values on the Purchasing Adjustments Enter window appear in the Document currency, which is determined by the 
Currency code assigned to the receiver you are adjusting. You can view costs in your home currency by selecting the Home currency option 
from the Show costs in... area. However, if you select this option, you will not be able to adjust cost values or miscellaneous charges. 

 

 This setting only affects how cost values are displayed on the Purchasing Adjustments Enter window. The Currency code assigned to a 
purchasing adjustment determines the currency that will be used for the distributions that are created when you post the adjustment. 

Receiver Tab 
When you select a receiver to adjust, the Receiver tab of the Purchasing Adjustments Enter window displays the Currency code that was 
originally assigned to the receiver and the corresponding Receiver Exchange rate. This tab also displays the Adjustment Exchange rate, 
which applies to the purchasing adjustment. By default, the Adjustment Exchange rate is the same as the Receiver Exchange rate, but you 
can modify it to account for changes in the exchange rate since the time the receiver was posted. 

 
To override the current Adjustment Exchange rate for the currency assigned to the purchasing adjustment, click the Change button and 
enter the new exchange rate on the Exchange Rates dialog. 

 Once you have posted a purchasing adjustment, you cannot change the exchange rate(s) for the adjustment. 

The Previous and Adjusted cost and miscellaneous charge values on this tab appear in the currency assigned to the selected receiver. If you 
modify the adjusted Subtotal for the entire receiver, it will be allocated to the lines on the original receiver in the specified currency. 

 You cannot change the Currency code assigned to a purchasing adjustment. 

© 2015 NCR, All rights reserved March 2015 38  



NCR Counterpoint  V8.5 Release Notes 

Lines Tab 
On the Lines tab, you can adjust the Received cost for items on the selected receiver in the currency that was originally assigned to the 
receiver. 

 

 You can only adjust the Received cost value for an item on the receiver if the Document currency option is selected in the Show costs in... 
area. 
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Misc charges Tab 
The Misc charges tab allows you to adjust miscellaneous charge amounts for the selected receiver. You cannot change the Currency 
assigned to a miscellaneous charge on a purchasing adjustment, although you can override the Exchange rate that was assigned to the 
currency when the receiver was posted. 

 

 You can only adjust the amount for a miscellaneous charge if the Document currency option is selected in the Show costs in... area. 

If you want to override the current Exchange rate for the currency assigned to the miscellaneous charge, click the Exch rates button to 
display the Exchange Rates dialog. 

 Once you have posted a purchasing adjustment, you cannot change the exchange rate(s) for the adjustment. 
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Multi-currency Purchasing: Returns to Vendors 
If multi-currency purchasing is enabled for your company, you can process returns to vendors (RTVs) in foreign currencies. This topic details 
the changes you will see on the Returns to Vendor Enter window (Purchasing > Returns to Vendor > Enter) when you are using multi-
currency purchasing. 

By default, cost values on the Returns to Vendor Enter window appear in the Document currency, which is determined by the Currency 
code assigned to the RTV. You can view costs in your home currency by selecting the Home currency option from the Show costs in... area. 
However, if you select the this option, you will not be able to edit Credit amount values for items on the Lines tab or Amount values for 
miscellaneous charges on the Misc charges tab. 

 
 This setting only affects how cost values are displayed on the Returns to Vendor Enter window. The Currency code assigned to an RTV 

determines the currency that will be used for the distributions that are created when you post the RTV. 

Vendor Tab 
When you enter or look up a Vendor number for a purchase request on the Vendor tab of the Returns to Vendor Enter window, the vendor's 
default Currency code and the current Exchange rate for that currency appear. 

 
If a default currency code is not assigned to the vendor, or you want to use a different currency for the RTV, enter or look up the appropriate 
Currency code. 

 If you change the Currency code for an RTV, a message appears, warning you that the currency has changed and that all lines on the 
purchase request will be reset to their default cost values. 
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To override the current Exchange rate for the currency assigned to the RTV, click the Change button and enter the new exchange rate on the 
Exchange Rates dialog. 

 Once you have posted an RTV, you cannot change the exchange rate(s) for the RTV. 

Lines Tab 
On the Lines tab, when you add an item to the RTV, you will specify the Credit amount for the item in the currency assigned to the RTV. 

 
 You can only modify the Credit amount value for an item on the RTV if the Document currency option is selected in the Show costs in... 

area. 
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Misc charges Tab 
The Misc charges tab allows you to record miscellaneous charges for an RTV, such as shipping or a restocking fee. If a currency code is 
assigned to a miscellaneous charge (in Setup > Purchasing > Control), the Misc charges tab displays the Currency and the corresponding 
Exchange rate. If a default currency is not assigned to a miscellaneous charge, the miscellaneous charge appears in the currency assigned 
to the RTV. 

 
The Amount you enter for each miscellaneous charge is recorded in the indicated Currency unless you select a different one. However, the 
Total misc amount in the totals area of the Misc charges tab always displays the total amount of all miscellaneous charges in the currency 
assigned to the RTV (or your home currency, if the Home currency option is selected in the Show costs... area). 

 You can only modify the Amount value for a miscellaneous charge if the Document currency option is selected in the Show costs in... area. 

If you want to override the current Exchange rate for the currency assigned to the miscellaneous charge, click the Exch rates button to 
display the Exchange Rates dialog. 

 Once you have posted an RTV, you cannot change the exchange rate(s) for the RTV. 
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Multi-currency Purchasing: Vouchering Receivings 
If you have multi-currency purchasing enabled for your company and you are using the Voucher Receivings function (System > 
Accounting > Voucher Receivings) to voucher receivings and RTVs to your accounting software, accounts payable transactions will always 
be created in your home currency. This means that Counterpoint will automatically convert foreign currency amounts you owe your vendors to 
your home currency during the vouchering process. 

By default, subtotals, miscellaneous charges, and totals on the Select receivers and Invoice tabs of the Voucher Receivings window 
appear in the Document currency, which is determined by the Currency code assigned to the selected receiver(s). You can view these 
values in your home currency by selecting the Home currency option from the Show costs in... area. If you select this option, you will not be 
able to edit Voucher amount values on the Select receivers tab or the Invoice amount on the Invoice tab. 

 

 All values on the Distributions tab appear in your home currency, regardless of the Show costs in... setting. 

Select receivers Tab 
On the Select receivers tab, you can modify the Voucher amount for the selected receiver and for any miscellaneous charges on the receiver 
in the currency that was assigned to the receiver. 
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Invoice Tab 
On the Invoice tab, you can modify the Invoice amount in the currency that was assigned to the receiver to specify the actual amount the 
vendor is billing you for the items on the receiver. 

 

You can also modify the exchange rate(s) for the voucher, allowing you to account for any exchange rate differences between the posted 
receiver and the invoice you received from the vendor. To change the effective exchange rate(s) for the voucher, click the Exchange rates 
button and enter the new exchange rate(s) on the Exchange Rates dialog. 

Exchange rate changes you make on the Invoice tab of the Voucher Receivings window will not affect the average cost or the B/S inventory 
value of the items on the selected receiver(s). Instead, exchange rate differences will be recorded as gains or losses in the Gain/loss account 
you specified on the Accounts Payable tab of the Accounting Interface window (Setup > System > Accounting Interface). If you want 
exchange rate changes to affect the average cost of your inventory, enter and post a purchasing adjustment to modify the exchange rate for a 
receiver before you voucher it. 

 Selecting the Home currency option on the Invoice tab will display the Gain/loss amount for the voucher, which indicates the amount that is 
gained or loss in the conversion from the currency assigned to the receiver to your home currency. This amount will be distributed to the 
Gain/loss account you specified on Accounts Payable tab of the Accounting Interface window. 

Modifying the exchange rate(s) for the voucher can also affect the Variance amount, which indicates the difference between the total amount 
of the receiver and the specified Invoice amount. 
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Distributions Tab 
Unlike the Select receivers and Invoice tabs, the Distributions tab displays all amounts in your home currency. 

 
If you use the Default distributions button to create distributions for invoices automatically, you may also need to manually create a 
distribution to your Gain/loss account to account for any Gain/loss amount that may have resulted from the conversion of foreign currency 
into your home currency. 

Exchange Rates 
If you are using multi-currency purchasing, the Exchange Rates dialog allows you to override the current exchange rate for the currency code 
assigned to a Purchasing document, as well as the current exchange rates for the currency codes assigned to any applicable miscellaneous 
charges. The exchange rate assigned to the document appears first on the Exchange Rates dialog, followed by the exchange rate for each 
applicable miscellaneous charge. 

 You can modify the exchange rate(s) on a purchase request, purchasing adjustment, return to vendor (RTV), or receiver without a 
corresponding purchase order, but you cannot edit the exchange rate(s) on a receiver that was created from a purchase order. 

 

To override an exchange rate, enter new exchange rate values in the corresponding field(s). When an exchange rate is different from the 
current exchange rate assigned to the indicated currency code, the Current exchange rate values appear in red. 

To apply the current exchange rate for the indicated currency code to the document or to a miscellaneous charge, click the corresponding Use 
current button. 

Click the Use current button at the bottom of the dialog to apply the current exchange rate for the indicated currency code(s) to the document 
and to all miscellaneous charges. 
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Value-added Tax in Purchasing 
NCR Counterpoint now allows for the inclusion of tax in Purchasing transactions, which allows merchants to comply with the regulatory 
requirements of countries that use value-added tax (VAT) or a similar tax system. 

With this enhancement, Counterpoint can calculate and display tax amounts on Purchasing documents, including purchase requests (and the 
resulting purchase orders), receivers, purchasing adjustments, and returns to vendors (RTVs). If you have configured Counterpoint to interface 
with your accounting software, tax amounts are also included when you voucher receivers that include it. 

 Purchasing tax is not calculated for quick receivings transactions (Purchasing > Quick Receivings > Enter). 

When you have configured this feature, each Purchasing document can be assigned a tax code, which determine the amount of tax the 
vendor will collect for the merchandise you are purchasing (or the amount of tax that will be refunded to you by the vendor, if you are 
processing an RTV). If a tax code is not assigned to a Purchasing document, no tax will be calculated for that transaction.  

You can change the amount of tax on a Purchasing document by changing the tax code assigned to the document, changing the taxable 
status of individual lines on the document, or by overriding the total tax amount for the document. 

When you post Purchasing documents that include tax, the appropriate amounts are distributed to the tax accrual account you have defined 
for your company and the Purchasing tax account assigned to each tax authority, which is different from the account used for Point of Sale 
transactions. 

 Counterpoint does not distinguish between "recoverable" purchasing tax (i.e., VAT a merchant pays to a vendor that is "recovered" when an 
item is sold a customer) and "irrecoverable" purchasing tax (i.e., VAT that cannot be recovered from customers that are simply expenses the 
merchant must bear). Thus, purchasing tax never affects inventory costs. 

This feature is fully compatible with multi-currency in purchasing, allowing you to view and enter tax amounts on Purchasing documents in 
foreign currencies. 

 Distributions for purchasing tax amount are always in your home currency. 

Configuring VAT in Purchasing 

Purchase Requests 

Receivings 

Purchasing Adjustments 

Returns to Vendors 

Vouchering Receivings 

Combined Tax History Report 
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Configuring Value-added Tax in Purchasing 
This topic details the process of configuring NCR Counterpoint to support value-added tax in Purchasing, allowing you to record and track the 
amount of tax you owe your vendors on Purchasing documents. 

Enabling Value-added Tax in Purchasing 
To enable the calculation of tax on Purchasing documents, select the Use tax in purchasing check box on the Main tab of the Purchasing 
Control window (Setup > Purchasing Control). 

 
You must also specify a Tax accrual account (along with the appropriate Profit center, if you are using profit centers) to track distributions 
for tax amounts you owe your vendors. 

 To disable the calculation of tax on Purchasing documents, clear the Use tax in purchasing check box. When you clear this check box, a 
message appears, alerting you that tax data will not be removed from existing Purchasing documents. 

 

Defining Value-Added Tax Codes 
If the same regulations govern the calculation of tax for Purchasing transactions and Point of Sale transactions for you, you can use the same 
tax codes, tax authorities, and tax rules in both areas of Counterpoint. However, if you require different tax rules for Purchasing transactions, 
due to regional regulations that apply to your vendors or your stocking locations, you will need to define new tax codes, tax authorities, and tax 
rules to calculate the appropriate amount of tax on Purchasing documents. 

For example, in certain Canadian provinces, both the Provincial Sales Tax (PST) and the Goods and Services Tax (GST) are value-added 
taxes that are collected by vendors (i.e., input taxes) and from customers (i.e., output taxes), so the same tax rules can apply to Purchasing 
transactions and to Point of Sale transactions. However, in other Canadian provinces (including British Columbia, Manitobia, and 
Saskatchewan), PST is not a value-added tax, requiring different tax codes for Purchasing transactions and Point of Sale transactions. 

 You may also need to define separate tax rules for "zero-rated" items, which differ from "exempt" items. Typically, exempt items are not 
subject to tax at all, which means that merchants do not collect tax from customers, do not pay tax to vendors, and cannot claim any tax credit 
for materials used to make exempt items. Zero-rated items, however, are items for which the applicable tax rate is 0%, which means that 
merchants do not collect tax from customers, but may still be able to claim an Input Tax Credit for tax paid to vendors. 

Use the Tax Authorities window (Setup > System > Tax Authorities) to define the necessary tax authorities and tax rules, and then assign 
those tax authorities to the appropriate tax codes using the Tax Codes window (Setup > System > Tax Codes). You will assign these tax 
codes to your vendors or stocking locations to determine how tax will be calculated on Purchasing documents for those vendors or locations. 
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For each tax rule in a tax authority, you must specify the Purchasing tax account (and the corresponding Profit center method, if you are 
using profit centers) on the Main sub-tab of the Rules tab on the Tax Authorities window to track distributions of value-added tax amounts 
you pay for Purchasing transactions. 

 
You should also select the appropriate PO tax misc charge check boxes on the Applies to sub-tab of the Rules tab to specify the 
miscellaneous charges the tax rule should calculate tax for on Purchasing documents, if any.  

 

© 2015 NCR, All rights reserved March 2015 49  



NCR Counterpoint  V8.5 Release Notes 

Assigning Tax Codes to Vendors and Locations 
Once you have defined the necessary tax codes to assess value-added tax on Purchasing documents, you can assign the appropriate Tax 
code to each vendor that collects tax on the Main tab of the Vendors window (Purchasing > Vendors). By default, when you create a 
Purchasing document for a vendor, Counterpoint uses the tax code assigned to the vendor to calculate the appropriate amount of tax for the 
Purchasing document. 

 
You can also assign a Tax code to each of your stocking locations on the Address tab of the Locations window (Setup > Inventory > 
Locations). 

 
If you want to use the tax code assigned to a location by default on Purchasing documents for the location, select Location from the 
Purchasing uses tax code from list box. 
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Assigning Tax Identification Numbers 
If you are required to track registered tax identification numbers, Counterpoint allows you to record them for your company, stores, stocking 
locations, and vendors. Tax ID numbers are stored with each Purchasing document, allowing you to recall them for auditing purposes. 

Enter your the tax identification number for your company in the Tax ID # field on the Address tab of the Company window (Setup > System 
> Company). By default, your company Tax ID # value will be used for all of your stores and locations, unless you assign a different value to 
individual stores or locations. 

 
If you need to track tax identification numbers for your vendors, enter a Tax ID # value for each vendor on the Address tab of the Vendors 
window (Purchasing > Vendors). 

 
The Tax ID # date field tracks the effective date for the vendor's Tax ID # value. By default, this field is set to the date on which you record the 
Tax ID # for a vendor, but you can change it, if necessary. 

 The Tax ID # and Tax ID # date field appear on the Vendors window only if the Use tax in purchasing check box is selected on the Main tab 
of the Purchasing Control window (Setup > Purchasing > Control). 

To track separate tax identification numbers for individual stores or stocking locations, enter a Tax ID # value for the store or the location on 
the Contacts tab of the Stores window (Setup > Point of Sale > Stores) or Address tab of the Locations window (Setup > Inventory  > 
Locations). 
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Designating VAT as Discountable 
If the tax you pay to your vendors is subject to vendor discounts, select the Discount tax check box for each applicable vendor terms code on 
the Vendor Terms Codes window (Setup > Purchasing > Terms Codes). 

 
When you use the Voucher Receivings function (System > Accounting > Voucher Receivings) to voucher a receiver from a vendor with a 
terms code that includes this setting, Counterpoint will calculate and apply the appropriate discount to the tax amount on the receiver. 

Value-added Tax: Purchase Requests 
If you are using value-added tax in purchasing, NCR Counterpoint will calculate tax on purchase requests for which a Tax code is specified. 
This topic details the changes you will see on the Purchase Requests Enter window (Purchasing > Purchase Requests > Enter) when you 
are using value-added tax in purchasing. 

 Tax is not calculated for purchase requests that are automatically created from drop-ship orders. To calculate and apply tax to a drop-ship 
purchase request, edit the purchase request before posting it. If you do not edit a drop-ship purchase request before it is posted, tax will be 
calculated and applied automatically to the receiver when you receive the resulting purchase order. 

Vendor Tab 
On the Vendor tab of the Purchase Requests Enter window, the Vendor tax ID # field indicates the tax identification number assigned to the 
vendor. 

Ship-to Tab 
The Ship-to tab displays Your Tax ID #, which is the Tax ID # assigned to the location specified on the purchase request or to your company, 
if a Tax ID # is not assigned to the location. 

Also, if you select the Allocated check box on this tab and choose to generate Separate purchase requests for the locations in the specified 
Location group, a tax code cannot be assigned to the allocated/separate purchase requests. To calculate tax for allocated/separate purchase 
requests, you must first post the purchase requests, and then use the Change Purchase Orders window (Purchasing > Purchase Orders 
> Change Purchase Orders) to apply the appropriate Tax code to the resulting purchase orders. 
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Order Tab 
The Order tab displays the default Tax code for the purchase request, if applicable, which is either the tax code assigned to the vendor or the 
location, depending on your configuration. 

 
 If a tax code is not assigned to the vendor or the location, the Tax code field will be blank, which means that Counterpoint will not calculate tax 

for the purchase request. 

You can enter or look up a different Tax code to override the default tax code for the purchase request. If you change the defaultTax code, 
the Tax code (normal) field appears, indicating the tax code that would normally apply to the purchase request. 

 
Click the Use normal tax code button to revert to the default Tax code for the purchase request. 

 After you post a purchase request, you can change the tax code on the resulting purchase order (Purchasing > Purchase Orders > Change) 
or on the corresponding receiver (Purchasing > Receivings > Enter) to recalculate the tax for the purchase. However, you cannot change 
the tax code for a purchase once you have posted the receiver. 
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Lines Tab 
As you add items to a purchase request on the Lines tab, Counterpoint uses the tax rules in the tax code assigned to the purchase request to 
calculate the amount of tax you owe the vendor for each line. The Order tax field displays the total amount of tax you owe the vendor for all of 
the items on the purchase request. 

 

 If you are using multi-currency purchasing, the Order tax total appears in the currency assigned to the purchase request or your home 
currency, depending the option you select from the Show costs in... area. However, when you post a purchase request, tax distributions are 
always in your home currency. 

If a line on the purchase request should not be subject to tax, select the line and clear the Taxable check box to remove the line from the tax 
calculation. When you save the line, the Order tax value is updated to display the new tax total for the purchase request. 

If you want to override the calculated tax total for the purchase request, click the Order tax field on the Lines tab and enter a new Order tax 
value on the Tax Override dialog. 

 
Click the Use Normal Tax button on the Tax Override dialog to revert to the Normal tax amount for the purchase request. 

 If you are using multi-currency purchasing, the values on the Tax Override dialog appear in your home currency and the currency assigned to 
the purchase request. 

The Add items button on the Lines tab—which allows you to add multiple items to a purchase request simultaneously—is not available if 
aTax code is assigned to the purchase request.An error message appears if you click this button when a foreign currency is assigned to a 
purchase request. 
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Value-added Tax: Receivings 
If you are using value-added tax in purchasing, NCR Counterpoint will calculate tax on receivers for which a Tax code is specified. This topic 
details the changes you will see on the Receivings Enter window (Purchasing > Receivings > Enter) when you are using value-added tax 
in purchasing. 

Receiver Tab 
If you are receiving a purchase order, the Tax code assigned to the purchase order appears on the Receiver tab of the Receivings Enter 
window, along with the Vendor tax ID # for the vendor and Your tax ID #. If you are receiving without a purchase order, the default Tax code 
for the receiver is the tax code that is assigned to the vendor or the location, depending on your configuration. 

 
In either case, you can enter or look up a different Tax code to override the default tax code for the receiver. If you change the default Tax 
code, the Tax code (normal) field appears, indicating the tax code that would normally apply to the receiver. 

 
Click the Use normal tax code button to revert to the default Tax code for the purchase request. 

 You cannot change the tax code for a purchase once you have posted the receiver. 
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Lines Tab 
On the Lines tab, the Tax field displays the total amount of tax you owe the vendor for the items on the receiver, as calculated by the tax rules 
in the tax code assigned to the receiver. If you add lines to the receiver, Counterpoint calculates the amount of tax you owe the vendor for 
each new line and updates the Tax total accordingly. 

 

 If you are using multi-currency purchasing, the Tax total appears in the currency assigned to the receiver or your home currency, depending 
the option you select from the Show costs in... area. However, when you post a receiver, tax distributions are always in your home currency. 

If a line on the receiver should not be subject to tax, select the line and clear the Taxable check box to remove the line from the tax 
calculation. When you save the line, the Tax value is updated to display the new tax total for the receiver. 

To override the calculated tax total for the receiver, click the Tax field on the Lines tab and enter a new Order tax value on the Tax Override 
dialog. 

 
Click the Use Normal Tax button on the Tax Override dialog to revert to the Normal tax amount for the receiver. 

 If you are using multi-currency purchasing, the values on the Tax Override dialog appear in your home currency and the currency assigned to 
the receiver. 
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Value-added Tax: Purchasing Adjustments 
If you are using value-added tax in purchasing, NCR Counterpoint will adjust the tax on a receiver for which a Tax code is specified when you 
enter a purchasing adjustment for the receiver. This topic details the changes you will see on the Purchasing Adjustments Enter window 
(Purchasing > Adjustments > Enter) when you are using value-added tax in purchasing. 

Receiver Tab 
When you select a receiver to adjust, the Receiver tab of the Purchasing Adjustments Enter window displays the Tax code that was 
assigned to the selected receiver, along with the Vendor tax ID # and Your tax ID #. 

 
If you adjust the Subtotal for the receiver on the Receiver tab, the Adj tax total for the receiver is recalculated automatically, based on the 
indicated Tax code. 

 If you are using multi-currency purchasing, the Adj tax value and other totals on this tab appear in the currency assigned to the receiver you 
are adjusting or your home currency, depending on the option you select from the Show costs in... area. However, when you post a 
purchasing adjustment, tax distributions are always in your home currency. 
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Lines Tab 
On the Lines tab, if you adjust the Received cost for items on the selected receiver, the Adj tax total is recalculated automatically. 

 

 If you are using multi-currency purchasing, the Adj tax value and other totals on this tab appear in the currency assigned to the receiver you 
are adjusting or your home currency, depending on the option you select from the Show costs in... area. However, when you post a 
purchasing adjustment, tax distributions are always in your home currency. 

To override the adjusted tax total, click the Adj tax field on the Lines tab and enter a new Order tax value on the Tax Override dialog. 

 
Click the Use Normal Tax button on the Tax Override dialog to revert to the Normal tax amount for the adjustment. 

 If you are using multi-currency purchasing, the values on the Tax Override dialog appear in your home currency and the currency assigned to 
the receiver you are adjusting. 

© 2015 NCR, All rights reserved March 2015 58  



NCR Counterpoint  V8.5 Release Notes 

Value-added Tax: Returns to Vendors 
If you are using value-added tax in purchasing, NCR Counterpoint will calculate tax on returns to vendors (RTVs) for which a Tax code is 
specified. This topic details the changes you will see on the Returns to Vendor Enter window (Purchasing > Returns to Vendor > Enter) 
when you are using value-added tax in purchasing. 

Vendor Tab 
On the Vendor tab of the Returns to Vendor Enter window, the Vendor tax ID # field indicates the tax identification number assigned to the 
vendor. 

RTV Tab 
The RTV tab displays the default Tax code for the RTV, if applicable, which is either the tax code assigned to the vendor or the location, 
depending on your configuration, along with Your tax ID #. 

 
 If a tax code is not assigned to the vendor or the location, the Tax code field will be blank, which means that Counterpoint will not calculate tax 

for the RTV. 

You can enter or look up a different Tax code to override the default tax code for the RTV. If you change the defaultTax code, the Tax code 
(normal) field appears, indicating the tax code that would normally apply to the RTV. 

 
Click the Use normal tax code button to revert to the default Tax code for the RTV. 

 You cannot change the tax code for an RTV once you have posted it. 
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Lines Tab 
As you add items to an RTV on the Lines tab, Counterpoint uses the tax rules in the tax code assigned to the RTV to calculate the amount of 
tax the vendor owes you for each line. The Tax field displays the total amount of tax for all of the items on the RTV. 

 
 If you are using multi-currency purchasing, the Tax value and other totals appear in the currency assigned to the RTV or your home currency, 

depending the option you select from the Show costs in... area. However, when you post an RTV, tax distributions are always in your home 
currency. 

If a line on the RTV should not be subject to tax, select the line and clear the Taxable check box to remove the line from the tax calculation. 
When you save the line, the Tax value is updated to display the new tax total for the RTV. 

If you want to override the calculated tax total for the RTV, click the Tax field on the Lines tab and enter a new Order tax value on the Tax 
Override dialog. 

 
Click the Use Normal Tax button on the Tax Override dialog to revert to the Normal tax amount for the RTV. 

 If you are using multi-currency purchasing, the values on the Tax Override dialog appear in your home currency and the currency assigned to 
the RTV. 

Value-added Tax: Vouchering Receivings 
If you are using value-added tax in purchasing, and you are using the Voucher Receivings function (System > Accounting > Voucher 
Receivings) to voucher receivings and RTVs to your accounting software, purchasing tax will be included in voucher totals for receivers and 
RTVs that include a Tax code. 

 If you are using multi-currency purchasing, Tax amounts and other values on the Select receivers and Invoice tabs of the Voucher 
Receivings window appear in the currency assigned to the selected receiver(s) or your home currency, depending the option you select from 
the Show costs in... area. However, all values on the Distributions tab appear in your home currency, regardless of the Show costs in... 
setting. 

 Counterpoint does not distinguish purchasing tax from other amounts in voucher totals. 
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Select receivers Tab 
The Select receivers tab displays the total amount of tax on the selected receiver (in the Received amounts column), the amount of tax that 
has already been vouchered for the receiver (in the Previously vouchered column), and the amount of tax you still owe for the receiver (in 
the Balance column). In the Voucher amount column, you can specify the amount of tax you want to voucher, which is set to the balance due 
by default. 

 

 If you are using multi-currency purchasing, you can only modify the Voucher amount for tax if you select the Home currency option from the 
Show costs in... area. 

Invoice Tab 
On the Invoice tab, you can modify the Tax amount to specify the actual amount of tax you were invoiced for the selected receiver(s). 

 
If you change the Tax amount for the invoice, the difference between the specified value and the amount of tax on the selected receiver(s) is 
indicated in the Variance field. 

 If you are using multi-currency purchasing, you can only modify the Tax value if you select the Home currency option from the Show costs 
in... area. 
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Distributions Tab 
The Distributions tab displays the amount of Tax on the selected receiver(s), along with the corresponding distribution to your Purchasing 
tax accrual account. You can modify the Amount for the purchasing tax distribution, if necessary. 

 

Combined Tax History Report 
This version of NCR Counterpoint includes the Combined Tax History report, which provides a combined view of taxes you collected from your 
customers (for Point of Sale transactions) and taxes you paid to your vendors (for purchasing transactions). 

 

 This report is available only if the Use tax in purchasing check box is selected on the Purchasing Control window (Setup > Purchasing > 
Control). 
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On the Combined Tax History window (System > Reports > Combined Tax Hist), you can select one of the following Report options: 

• The Combined Tax History by Tax Authority option groups Point of Sale tax or Purchasing tax by tax authority when you double-
click Tax collected from Customers or Tax paid to Vendors, respectively, on the Preview tab. 

 

• The Combined Tax History by Documents option groups Point of Sale tax or Purchasing tax by document when you double-click 
Tax collected from Customers or Tax paid to Vendors on the Preview tab. 
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Parameters Tab 
The Parameters tab allows you to choose whether you want to include Point of Sale taxes or Purchasing tax on the COMBINED TAX HISTORY 
report, as well as to specify the store, location, and date range for the report. 

 
Select the Include POS taxes check box to include taxes you collected from customers for Point of Sale transactions on the COMBINED TAX 
HISTORY report, and then specify the Store for the report or click the All Stores button to include Point of Sale transactions from all your 
stores. 

Select the Include Purchasing taxes check box to include taxes you paid to vendors for Purchasing transactions on the report, and then 
specify the Location for the report or click the All locations button to include Purchasing transactions for all locations. 

Select a pre-defined date range from the Dates list box, or use the From and To fields to specify the data range for the report. 

Tax History by Tax Authority Tab 

Use the Tax History by Tax Authority tab to define filtering criteria to limit the transactions that appear on the report. 

 
 You can customize the fields on the Tax History by Tax Authority tab, as usual. 
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Ecommerce 

Drop Shipping NCR Retail Online Orders 
In this version of NCR Counterpoint, you can designate lines on orders that originated in an NCR Retail Online store as Drop-ship lines and 
have those items shipped directly from your vendors to your online customers. 

 Orders imported from NCR Counterpoint Online (CPOnline) cannot be drop shipped. 

To drop ship NCR Retail Online orders, you must first configure your store to allow drop shipments, authorize users to create drop-ship lines 
and process drop-ship purchasing documents, define a drop-ship clearing account, assign the default batch for drop-ship purchasing 
documents, specify the next sequential purchase request number, and assign primary vendors to your items.  

 Refer to Drop-ship orders: Setting up drop-ship orders in the NCR Counterpoint online help for more information about configuring 
Counterpoint to process drop-ship order lines. 

In Ticket Entry or Touchscreen Ticket Entry, when you edit an order that has been imported from NCR Retail Online (NRO) via 
Ecommerce > Ecommerce Import, you can change one or more lines on the order to Drop-ship lines. 

  

When you save the edited eCommerce order, Counterpoint automatically creates a drop-ship purchase request for each primary vendor from 
whom items are to be drop shipped. You can then review and post the drop-ship purchase request, which creates the corresponding drop-ship 
purchase order for the vendor, who will ship the item(s) to the customer. When the vendor notifies you the item has shipped, you can receive 
the corresponding purchase order, creating a release ticket for the item(s) and completing the drop-ship process. 

 Refer to the Drop-ship orders topics in the NCR Counterpoint online help for more information about processing drop-ship orders. 

Once you have changed one or more lines on an imported eCommerce order to Drop-ship lines, you can still edit the order in Ticket Entry. 
However, you cannot modify or delete a drop-ship order line that has been moved to a drop-ship purchase order (i.e., for which the 
corresponding drop-ship purchase request has been posted). Only drop-ship order lines that are still on unposted drop-ship purchase requests 
can be edited. 

Shipping charges for eCommerce orders are imported into Counterpoint as miscellaneous charges, as usual. However, because they 
represent the amount the customer is charged for shipping, miscellaneous charges are not carried over to drop-ship purchase requests that 
are created when you change lines on an eCommerce order to Drop-ship lines. To record the amount a vendor charges you to drop-ship 
items, you must enter miscellaneous charges on the drop-ship purchase request or the corresponding drop-ship receiver. 

 If you need to change the amount a customer is charged to drop-ship an eCommerce order, you must edit the Misc charges amount for the 
order before you post the corresponding drop-ship purchase requests. 

Ordinarily, drop-ship items must be paid for in full when they are ordered. However, because eCommerce orders are not designated as drop-
ship orders when they are imported into Counterpoint, final payments for eCommerce order lines that are changed to Drop-ship lines are not 
authorized until the corresponding drop-ship receiver is posted. 
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System 

Automatic File Sync when Registering Workstations 
In this version, when you register a workstation—using the Workstations window in NCR Counterpoint (Setup > System > Workstations) or 
the NCR Counterpoint Management Console (Start > Programs > NCR Counterpoint > Utilities > Management Console)—File Sync 
automatically synchronizes the workstation with the company configuration directory on the associated site server (e.g., C:\Program 
Files\Radiant Systems\Counterpoint\CPSQL.1\TopLevel\MyCompany\Configuration). This enhancement ensures that each workstation 
has the latest data dictionary settings, custom reports, item and customer images, and other configuration files immediately upon registration. 

Changing the Default Timeout for Data Aggregation 
By default, NCR Counterpoint's data aggregation tasks—which summarize the necessary sales history data for the Dashboard, forecast data 
for forecast-driven replenishment, and transaction log data for the Point of Sale Exceptions report—stop processing after 15 minutes of 
activity. In this version, you can change the default timeout setting for data aggregation tasks. This enhancement allows data aggregation 
tasks to run for a longer period of time, which is particularly useful during the initial aggregation of existing data. 

Follow these steps to change the default timeout setting for data aggregation tasks: 

1.  Open the AggSumarization.xml file in the \Bin subdirectory of your Counterpoint installation directory (e.g., C:\Program 
Files\Radiant Systems\Counterpoint\CPSQL.1\Bin). 

2. Find the following entry in the <parameters> section: 

<param name="AggRuntimeMinutes" value="15"/> 

3. Change the parameter value to the number of minutes you want the aggregation tasks to run each time they are scheduled. For 
example, to allow the aggregation tasks to run for an hour, change the value to "60" (as indicated below). 

<param name="AggRuntimeMinutes" value="60"/> 

 The AggRuntimeMinutes parameter must be set to a number of minutes that is less than the time interval specified for data aggregation 
tasks in the Set interval field on the Data Aggregation tab of the NCR Counterpoint Management Console utility (Start > NCR Counterpoint 
> Utilities > Management Console). For example, if the Set interval value is set to 1 hour, the AggRuntimeMinutes parameter must be set 
to 59 minutes or less. 

In a Multi-Site environment, change this parameter on your Hub server and on each of your remote servers. 

4. Save your changes and restart CPServices on your server. 
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Company Db View in Management Console 
In this version, the NCR Counterpoint Management Console (Start > Programs > NCR Counterpoint > Utilities > Management Console) 
includes the Company Db view, which allows you to review and manage each of your NCR Counterpoint company databases. The Company 
Db view includes a Summary tab that displays general information about a company database, along with the Workstations, Db 
Maintenance, and Data Aggregation tabs that previously appeared on the Server view. 

 
 These tabs have been removed from the Server view, which now includes only the Summary, Communication Status, and Mail tabs. 

To display the Company Db view, double-click the  server icon (which replaces the  icon) in the Object Explorer, and then click the 
 icon for the company database you want to manage. 

Summary  
The Summary tab displays general information about the company database, including the Company alias, Database name, and Database 
version for the database. This tab also includes the new Database state field, which indicates whether the company database is available 
and its current status (e.g., undergoing maintenance). 
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Workstations  
The Workstations tab displays the Point of Sale stations that have been created for the company and the workstations that have been 
assigned to them, sorted by Workgroup. This tab also allows you to register a workstation, assigning it to a particular Point of Sale station, or 
remove a workstation from the company, disassociating it from its assigned Point of Sale station. 

 

 This tab is identical to the Workstations tab that previously appeared on the Server view. 
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Db Maintenance 
The Db Maintenance tab allows you to define a daily maintenance schedule for the company database, during which the NCR Counterpoint 
Service (CPServices) will suspend all operations, allowing you to perform any SQL Server maintenance functions that require access to your 
database. 

 

 This tab is identical to the Maintenance tab that previously appeared on the Server view. 
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Data Aggregation 
The Data Aggregation tab allows you to schedule NCR Counterpoint's various data aggregations tasks, which summarize the necessary 
sales history data for the Dashboard, forecast-driven replenishment, and transaction log data for the POINT OF SALE EXCEPTIONS report. 

 

 This tab is identical to the Data Aggregation tab that previously appeared on the Server view. 

Default File Sync Schedule Updated 
In this version, the default File Sync schedule has been updated to synchronize remote servers in a Multi-Site environment with the Hub 
server at 1:00 AM, and then synchronize all of the workstations registered to each remote server at 3:00 AM. This enhancement allows data 
dictionary settings, custom reports, updated item or customer images, and other configuration changes to be fully synchronized throughout a 
Multi-Site environment overnight. 

 You can still use the NCR Counterpoint Management Console (Start > Programs > NCR Counterpoint > Utilities > Management Console) 
to initiate File Sync requests for remote server and workstations on demand. 
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Hosted Online Help 
The NCR Counterpoint online help—including the NCR Counterpoint V8.5 Installation Guide, Update Guide, and Release Notes—is now 
hosted at www.ncrcounterpointhelp.com. 

To allow your Counterpoint server(s) and workstations to access the NCR Counterpoint online help, configure your network firewall(s) to allow 
outbound traffic to ncrcounterpointhelp.com via port 80. 

If you have configured your network to prevent your Counterpoint server or workstation(s) from accessing the Internet, you may install the 
online help locally by following these steps: 

1. If you are a merchant, log in to the NCR Counterpoint User Portal at https://userportal.counterpointpos.com and browse to the 
Support > NCR Counterpoint > Software Documentation page. 

If you are an NCR Counterpoint Retail Partner, log in to the NCR Counterpoint Partner Portal at 
https://retailchannel.radiantsystems.com and browse to the Technical Services > Software Documentation page. 

2. Click the download link for the NCR Counterpoint V8.5 Online Help under NCR Counterpoint V8.5 Documentation to download 
the online help. 

3. Copy the V85_CounterpointHelp.zip file to the Counterpoint installation directory on your server or workstation (e.g., C:\\Program 
Files (x86)\Radiant Systems\Counterpoint\CPSQL.1) and extract the archive. 

 Repeat these steps for each of your server(s) and workstation(s). 

 If you install the online help locally, you should follow these steps periodically to ensure that your local online help to include the latest content 
and revisions. 

Log Viewer Enhancements 
In this version, the Log Viewer utility (Start > Programs > NCR Counterpoint > Utilities > Log Viewer)—which allows you to review activity 
logs for CPServices—includes several enhancements that are designed to improve the utility's overall usability. 

The title bar of the Log Viewer window now include the path and name of the directory that contains the log files you are currently viewing. 
Also, logs are automatically refreshed and displayed in the Log Viewer window when you start the utility; you are no longer required to click 
the Start button to display log entries. Further, the default width of the Message column has been increased to display more text. 

 

In addition to these minor improvements, the Log Viewer utility includes two significant functional enhancements. 
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Message Content Highlighting 
You can now quickly distinguish log entries based on their message content by entering a specific word or text string in the Content highlight 
field and clicking the Set button. 

 
All log entries whose Message value includes the text you specified are highlighted in bold, purple text, allowing you to easily spot those log 
entries. 

 

To stop highlighting log entries that include the specified content, click the  button next to the Content highlight field. 

Dynamic Filtering and Highlighting 
You can now dynamically filter and highlight log entries by Severity, Module, or Thread number by right-clicking a log entry in the appropriate 
column and selecting Set highlight or Set filter from the right-click menu. 

 
If you select Set highlight, all log entries whose Severity, Module, or Thread value match the selected entry are highlighted in yellow. 

 
If you select Set filter, the Log Viewer window is refreshed to display only those log entries whose Severity, Module, or Thread value match 
the selected entry. 
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To remove the current highlight or filter, right-click a log entry and select Remove current highlight or Remove current filter. 

Microsoft SQL Server 2005/2008 Support Discontinued 
Support for Microsoft SQL Server 2005 and SQL Server 2008 has been discontinued in NCR Counterpoint V8.5, as outlined below. 

SQL Server 2005 
If you are using SQL Server 2005, you must upgrade to SQL Server 2008 R2 or SQL Server 2012 before updating to NCR Counterpoint V8.5.  

If you do not do so, the compatibility level of your Counterpoint database will not be set automatically during the update process. If you attempt 
to log in to a Counterpoint database with the wrong compatibility level, a message appears, alerting you that you must update the database 
compatibility level. 

 

Follow these steps to correct the database compatibility level for your Counterpoint database, if necessary: 

1. From the Windows Start menu, select Programs > Microsoft SQL Server 2008 R2/2012 > SQL Server Management Studio to 
start Microsoft SQL Server Management Studio. 

2. On the Connect to Server dialog, enter the Login ID and Password for a SQL server login with sysadmin rights to your Counterpoint 
database, and click Connect. 

3. In the Object Explorer tree, expand the Databases folder, right-click your Counterpoint database, select Properties, and then select 
the Options page on the Database Properties window. 

4. If you have upgraded from SQL Server 2005 to SQL Server 2008 R2, select SQL Server 2008 (100) from the Compatibility level list 
box. 

 
If you have upgraded from SQL Server 2005 to SQL Server 2012, select SQL Server 2012 (110) from the Compatibility level list 
box. 

5. Click OK to save your changes and close the Database Properties dialog. 

6. Quit SQL Server Management Studio. 

SQL Server 2008 
SQL Server 2008 has not been certified and is not officially supported for use with NCR Counterpoint V8.5. If you are using SQL Server 2008, 
Counterpoint may continue to operate after you update to V8.5, but we strongly recommend upgrading to SQL Server 2008 R2 or SQL Server 
2012. 
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Microsoft SQL Server 2012 Support 
NCR Counterpoint V8.5 has been certified for use with Microsoft SQL Server 2012. 

If you upgrade to SQL Server 2012 from a previous version, you must use SQL Server Management Studio (Start > All Programs > 
Microsoft SQL Server 2012 > SQL Server Management Studio) to grant the NT AUTHORITY\SYSTEM login sysadmin rights to your 
server. To do this, open the Security > Logins folder in the Object Explorer tree, double-click the NT AUTHORITY\SYSTEM login, select the 
Server Roles page on the Login Properties window, select the sysadmin check box, and click OK. 

 If you are running SQL Server 2012 on Microsoft Windows 8.1, your Windows login must also have sysadmin rights to your server. 

You will also need the SQL Server 2012 Shard Management Objects (SMO) and CLR Types, which you can install by running the 
CPSQLPrerequisites.exe installer that is included with the NCR Counterpoint V8.5 Complete and Update images. 

 If you install SQL Server 2012, you will be unable to use Counterpoint's Data Migration utility and any of Counterpoint's export accounting 
interfaces. 

Resources and Locks Moved to the Counterpoint Database 
Previously, NCR Counterpoint relied on a third-party database program, DBISAM, to store resources and locks. In this version, resources and 
locks have been moved to the NCR Counterpoint database, where they are managed by the Microsoft SQL Server Database Engine directly. 
This enhancement provides increased stability and reliability, while ensuring that inactive resources and locks that may have been "orphaned" 
by an unexpected software termination are removed automatically. 

Sample File Sync Configuration Files 
This version of NCR Counterpoint includes two sample File Sync configuration files to illustrate appropriate synchronization settings for 
workstations and servers. The FileSyncConfig_SampleClient.xml files includes sample configuration settings for offline workstations and 
Multi-Site remote servers, while the FileSyncConfig_SampleServer.xml file outlines a sample configuration for a standalone server, WAN 
server, or Multi-Site Hub server. 

You can find the sample File Sync configuration files in the \Bin subdirectory of your Counterpoint installation directory (e.g., C:\Program 
Files\Radiant Systems\Counterpoint\CPSQL.1\Bin). 

Single-Line Security Log Format 
Previously, log entries for login attempts, changes to user accounts, changes to store and station settings, and other security-related events 
were recorded in a multi-line format to the SECURITY.LOG file in the Counterpoint installation directory (or the 
SECURITY_MACHINENAME.LOG file for each workstation in a WAN). In this version, SECURITY.LOG entries appear in a single-line, 
comma-separated format, which allows for easier integration into a centralized logging environment. 

© 2015 NCR, All rights reserved March 2015 74  



NCR Counterpoint  V8.5 Release Notes 

Translating Text Elements into Other Languages 
This version allows merchants to translate most displayed text elements in NCR Counterpoint—including field and button labels, window titles, 
menu items, report titles, report column labels, message text, and other user interface elements—into languages other than English and have 
the translated text appear throughout the software. 

Translation is accomplished through a series of portable object (.po) files that contain the default values for all translatable text elements in 
Counterpoint. Once these files have been generated, they can be translated into different languages by a variety of translation tools or sent to 
a third-party translation service. When the translation process is complete, the translated .po files must be compiled into machine object (.mo) 
files, which Counterpoint uses to display the translated text elements. 

 NCR Counterpoint does not currently support translation into unicode languages. 

In general, the following text elements in Counterpoint can be translated: 

• Field labels 

• Window and dialog titles 

• Toolbar items 

• Message dialog text and button labels 

• Report titles, columns, and labels 

• Label columns 

• Touchscreen codes 

• Lookup mapping 

Areas that cannot currently be translated include: 

• Work Center 

• Device Management 

• RDLC Editor 

• Other Counterpoint utilities 

• Online help text 

• Hard-coded text elements 

The following topics outline the process of translating text elements in Counterpoint, including installing the necessary translation components, 
creating portable object files, compiling translated files into machine object files, and modifying the Counterpoint application shortcut to display 
translated text. 

 In a Multi-Site environment, you must create and maintain your translation (.po and .mo) files at the Hub site, so you should perform the 
following procedures on your Hub server (or a workstation connected to your Hub server). Translation files will automatically be sent to 
Remote servers (and offline workstations, if you are using Offline Ticket Entry) during file synchronization. 
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Install Translation Components 
Follow these steps to install the Gettext command and other components that are necessary for translation: 

1. After you have updated your NCR Counterpoint system to V8.5, browse to the \Bin directory of your Counterpoint installation directory 
(e.g., C:\Program Files (x86)\Radiant Systems\Counterpoint\CPSQL.1\Bin) and double-click the dxgettext-1.2.2.exe file to start 
the GNU Gettext for Delphi and C++ Builder installer. 

2. On the Welcome dialog, click Next. 
3. On the Select Destination Location dialog, click Next to accept the default installation directory. 

4. On the Select Start Menu Folder dialog, select the Don't create a Start Menu folder check box, and then click Next. 
5. On the Select Additional Tasks dialog, leave the Integrate into desktop environment and Modify path (required to make it work) 

check boxes selected, clear the Create icon on desktop check box, and then click Next. 

 

6. Click Next on the Ready to Install to dialog to begin the installation. 

7. When the installation is complete, a message appears, indicating that the necessary applications have been installed. Click OK to 
close the message. 
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8. On the Completing the GNU Gettext for Delphi and C++ Builder Setup Wizard dialog, select the Yes, restart the computer now 

option and click Finish to restart your computer. 

 

Create Portable Object Files for Translation 
Once you have installed Gettext and the other necessary components, folllow these steps to create the necessary portable object (.po) files 
for the translatable text elements in NCR Counterpoint: 

1. Click the Start button and type cmd in the search field. 

2. Right-click cmd.exe and click Run as Administrator to open a command prompt. 

 

3. Browse to your company directory in your Counterpoint installation directory (e.g., C:\Program Files (x86)\Radiant 
Systems\Counterpoint\CPSQL.1\Toplevel\MyCompany). 

4. Type the following command and press [Enter]: 

..\..\bin\updateallpo.bat "%cd%" 

This process creates the following .po files in the \Toplevel\System\Dictionary\Locale directory of your Counterpoint installation directory: 

• Columns.po 

• default.po 

• Indexes.po 

• Messages.po 

• reports.po 

• Tables.po 
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When the batch file is finished, you can send these .po files in a translation tool or send them to the third-party translation service of your 
choice to have them translated into the appropriate language. 

 If you have already customized any of the text elements in Counterpoint via the Data Dictionary, Text Dictionary, Menu Editor, or Toolbar 
Editor, the batch file will incorporate your custom text into the generated .po files. 

Copy and Compile Translated Files 
When the translation process is complete and you have received the updated .po files from your translation service, follow these steps to copy 
the translated files into the appropriate directory and compile them into machine object (.mo) files that Counterpoint will use: 

1. Browse to the \Toplevel\System\Dictionary\Locale directory of your Counterpoint installation directory. 

 If you are managing multiple companies and you want to maintain different translation files for a particular company, browse to the 
\Configuration\Dictionary\Locale subdirectory of the corresponding company directory (e.g., C:\Program Files (x86)\Radiant 
Systems\Counterpoint\CPSQL.1\Toplevel\MyCompany) instead of the \Toplevel\System\Dictinoary\Locale directory, and then complete 
the remaining steps. The translated files will apply only to the specified company, just like any other customization. 

2. Create a new language directory for the translated files. We recommend using an abbreviation to identify the language into which the 
files were translated. For example, you might create a \fr directory for French, a \sp directory for Spanish, and so forth). 

3. Create a directory named lc_messages in the language directory you created (e.g., \fr\lc_messages), and then copy the translated 
.po files into this directory. 

 By default, the untranslated (i.e., English) versions of the .po files are stored in the \en\lc_messages directory, which was created 
automatically. 

4. Browse to the \lc_messages directory you created, right-click the first .po file in the list (i.e., Columns.po), and select Compile to mo 
file to create the corresponding .mo file, which will allow Counterpoint to display the translated text. 

 

 Repeat this step for each translated .po file. 

 Each time the content of a .po file changes, you must recompile the file to update the corresponding .mo file. If you modify or revise a 
translation file, your changes will not appear in Counterpoint until you right-click the .po file and select Complie to mo file again. 
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Modify the NCR Counterpoint Shortcut 
Once your translated .po files are in place and you have compiled them into .mo files, follow these steps to configure NCR Counterpoint to 
use your translated files instead of the default (i.e., English) files: 

1. Right-click the NCR Counterpoint shortcut in the Start > Programs menu and select Properties. 

2. On the Shortcut tab, add the /locale [dir] parameter to the end of the command in theTarget field, where [dir] is the language 
directory that contains your translated files. 

 
For example, if your translated files are in the \fr directory, add /locale fr to the Target field. 

3. Click OK to save your changes. 

When you start NCR Counterpoint using the modified shortcut, the translated text appears throughout the software. If you support multiple 
languages, you can create a shortcut for each language you support on each workstation, or you can configure different workstations to 
display different translation files (e.g., one workstation might display French text, while another displays English text). 
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Viewing Service Pack Level 
In this version, the View Environment Settings window (System > Views > Environment Settings) displays the current Service Pack level of 
your NCR Counterpoint installation, allowing you to quickly determine which Service Pack (if any) is installed. 

 
The current Service Pack level also appears on the Version Info tab of the About NCR Counterpoint dialog (Help > About Counterpoint). 

 

Windows 8.1 and Windows Server 2012 R2 Support 
Microsoft Windows 8.1 and Windows Server 2012 R2 are now certified and supported for use with NCR Counterpoint. 

 If you update existing NCR Counterpoint workstations or servers to Windows 8.1 or Windows Server 2012 R2 and you are using Microsoft 
SQL Server 2008 R2, you must also download and install Service Pack 2 for SQL Server 2008 R2 on your SQL server. 
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Accounting 

Microsoft Dynamics GP 2013 
This Service Pack includes a direct interface to Microsoft Dynamics GP 2013 (formerly Great Plains), allowing you to transfer distributions and 
voucher receivings to your General Ledger and Accounts Payable modules. You can also use this interface to import accounts from your 
General Ledger into Counterpoint and to exchange vendor information between Accounts Payable and Counterpoint. 

Direct interfaces to Microsoft Dynamics GP v9, v10, and 2010 R2 are still supported. 

 
Refer to the Accounting Interface topics in the Counterpoint online help for more information about setting up and using accounting interfaces. 

Passport v12 Export Interface 
This Service Pack includes an export accounting interface for Passport Business Solutions v12, which allows you to transfer distributions and 
voucher receivings using a pre-defined Data Transformation Services (DTS) package. 

The export interfaces for Passport v11 is still supported. 

 

Refer to the Accounting Interface topics in the Counterpoint online help for more information about setting up and using export interfaces. 
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QuickBooks 2015 Direct Interface 
This Service Pack includes a direct interface to QuickBooks 2015, allowing you to transfer distributions and voucher receivings to your 
General Ledger and Accounts Payable modules. You can also use this interface to import accounts from your General Ledger into 
Counterpoint and to exchange vendor information between Accounts Payable and Counterpoint. 

Direct interfaces to QuickBooks 2003 through 2014 are still supported. 

 

The QuickBooks 2015 accounting interface requires QuickBooks Foundation Classes (QBFC) 8.0 or later. To install QBFC 8.0, browse to the 
\Bin subdirectory of your Counterpoint workstation directory (e.g., C:\Program Files\Radiant Systems\Counterpoint\CPSQL.1 - Station), 
double-click the QBFC8_0Installer.exe file, and follow the on-screen instructions. 

 If you are using Counterpoint on a standalone server/workstation, you will find the QBFC8_0Installer.exe file in the \Bin subdirectory of your 
Counterpoint server directory (e.g., C:\Program Files\Radiant Systems\Counterpoint\CPSQL.1). 

Refer to the Accounting Interface topics in the Counterpoint online help for more information about setting up and using accounting interfaces. 

QuickBooks 2015 Export Interface 
This Service Pack includes an export accounting interface for QuickBooks 2015, which allows you to transfer distributions and voucher 
receivings using a pre-defined Data Transformation Services (DTS) package. 

Export interfaces for QuickBooks 2000 through 2015 are still supported. 

 

Refer to the Accounting Interface topics in the Counterpoint online help for more information about setting up and using export interfaces. 
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QuickBooks 2014 Direct Interface 
This Service Pack includes a direct interface to QuickBooks 2014, allowing you to transfer distributions and voucher receivings to your 
General Ledger and Accounts Payable modules. You can also use this interface to import accounts from your General Ledger into 
Counterpoint and to exchange vendor information between Accounts Payable and Counterpoint. 

Direct interfaces to QuickBooks 2003 through 2013 are still supported. 

 

The QuickBooks 2014 accounting interface requires QuickBooks Foundation Classes (QBFC) 8.0 or later. To install QBFC 8.0, browse to the 
\Bin subdirectory of your Counterpoint workstation directory (e.g., C:\Program Files\Radiant Systems\Counterpoint\CPSQL.1 - Station), 
double-click the QBFC8_0Installer.exe file, and follow the on-screen instructions. 

 If you are using Counterpoint on a standalone server/workstation, you will find the QBFC8_0Installer.exe file in the \Bin subdirectory of your 
Counterpoint server directory (e.g., C:\Program Files\Radiant Systems\Counterpoint\CPSQL.1). 

Refer to the Accounting Interface topics in the Counterpoint online help for more information about setting up and using accounting interfaces. 

QuickBooks 2014 Export Interface 
This Service Pack includes an export accounting interface for QuickBooks 2014, which allows you to transfer distributions and voucher 
receivings using a pre-defined Data Transformation Services (DTS) package. 

Export interfaces for QuickBooks 2000 through 2013 are still supported. 

 

Refer to the Accounting Interface topics in the Counterpoint online help for more information about setting up and using export interfaces. 
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QuickBooks 2013 Direct Interface 
This Service Pack includes a direct interface to QuickBooks 2013, allowing you to transfer distributions and voucher receivings to your 
General Ledger and Accounts Payable modules. You can also use this interface to import accounts from your General Ledger into 
Counterpoint and to exchange vendor information between Accounts Payable and Counterpoint. 

Direct interfaces to QuickBooks 2003 through 2012 are still supported. 

 

The QuickBooks 2013 accounting interface requires QuickBooks Foundation Classes (QBFC) 8.0 or later. To install QBFC 8.0, browse to the 
\Bin subdirectory of your Counterpoint workstation directory (e.g., C:\Program Files\Radiant Systems\Counterpoint\CPSQL.1 - Station), 
double-click the QBFC8_0Installer.exe file, and follow the on-screen instructions. 

 If you are using Counterpoint on a standalone server/workstation, you will find the QBFC8_0Installer.exe file in the \Bin subdirectory of your 
Counterpoint server directory (e.g., C:\Program Files\Radiant Systems\Counterpoint\CPSQL.1). 

Refer to the Accounting Interface topics in the Counterpoint online help for more information about setting up and using accounting interfaces. 

QuickBooks 2013 Export Interface 
This Service Pack includes an export accounting interface for QuickBooks 2013, which allows you to transfer distributions and voucher 
receivings using a pre-defined Data Transformation Services (DTS) package. 

Export interfaces for QuickBooks 2000 through 2012 are still supported. 

 

Refer to the Accounting Interface topics in the Counterpoint online help for more information about setting up and using export interfaces. 
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Sage 50 2013 Export Interface 
This Service Pack includes an export accounting interface for Sage 50 2013 (formerly Peachtree), which allows you to transfer distributions 
and voucher receivings using a pre-defined Data Transformation Services (DTS) package. 

Export interfaces for Peachtree 2005 through 2012 are still supported. 

 
 The Accounting system option for Peachtree 2005-2008 has been changed to Sage 50 (formerly Peachtree) 2005-2008 (Export). 

Refer to the Accounting Interface topics in the Counterpoint online help for more information about setting up and using export interfaces. 
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Sage Accounting Software Renamed 
The Accounting system list box on the Accounting Interface window (Setup > System > Accounting Interface) includes the following 
renamed Sage accounting software: 

 

• Sage 50 (formerly Peachtree) 

• Sage 100 Standard (formerly Mas90) 

• Sage 100 Advanced (formerly Mas200) 

• Sage 300 (formerly Accpac) 

• Sage 100 Fund Accounting (formerly MIP Fund Accounting) 
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Credit Cards 

Chase Paymentech Canada Support 
This version of NCR Counterpoint allows you to process Canadian debit and credit card transactions through Chase Paymentech Canada via 
the Tender Retail platform. 

 Chase Paymentech does not support check processing, EBT food stamps, address verification and card identification services, or stored value 
cards. In addition, only Retail merchants can process transactions through Chase Paymentech Canada. 

To process Canadian debit and credit card transactions through Chase Paymentech Canada, you must obtain an Ingenico iPP320 Secure 
PIN Entry Device (SPED) from Chase. Credit and debit transactions will be transmitted directly to Chase from the SPED via the Internet, 
bypassing Counterpoint's normal authorization and settlement process. 

You must also obtain a Store ID for each store that will process debit and credit card transactions through Chase Paymentech Canada. 

 Because transactions processed through Chase Paymentech Canada are not settled through Counterpoint, they will not appear on the PRE-
SETTLEMENT LIST, SETTLEMENT HISTORY, and SETTLEMENT JOURNAL reports. 

 You must purchase and register the Credit Cards Option to process Canadian debit and credit card transactions through Chase Paymentech 
Canada. 

Configuring a Store to Use Chase Paymentech Canada 
Follow these steps to configure a store to process debit and credit card transactions through Chase Paymentech Canada: 

1. Select Setup > Point of Sale > Stores from the Counterpoint main menu to display the Stores window. 

2. Enter or look up the Store you want to configure, and then select the Credit Cards tab. 

 

3. Enter the Store ID provided to you by Chase Paymentech Canada in the Merchant number field. 

4. Select Tender Retail from the Processor list box. 

5. Click the  button to save your changes. 

 Repeat steps 2 through 5 for each store you want to configure to process debit and credit cards through Chase Paymentech Canada. 
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Installing Merchant Connect Multi 
Follow these steps to install the Merchant Connect Multi software on your workstation, allowing your Ingenico iPP320 SPED to connect to 
Chase Paymentech Canada: 

1. Browse to the \Bin\MCM directory in the Counterpoint directory on the workstation to which the iPP320 SPED is connected (e.g., 
C:\Program Files (x86)\Radiant Systems\Counterpoint\CPSQL.1 - Station\Bin\MCM). 

2. Extract the MCM_EMV_Installation_kit_4_2_15_build96.zip to a temporary directory on your workstation. 

3. Browse to the directory to which you extracted the MCM_EMV_Installation_kit_4_2_15_build96.zip file and double-click Setup.exe 
to start the Merchant Connect Multi Setup Wizard. 

4. Click Next on the Welcome dialog, click Next on the Select Installation Folder dialog to accept the default installation directory, and 
then click Install to install the Merchant Connect Multi software for the iPP320. 

5. When the installation is complete, click Finish to close the Merchant Connect Multi Setup Wizard. 

6. Return to the \Bin\MCM directory in your workstation's Counterpoint directory and extract the MCM_Update_4_2_16_build.zip file to 
a temporary directory. 

7. Copy the contents of the directory to which you extracted the MCM_Update_4_2_16_build.zip file to the C:\MerchantConnectMulti 
directory on your workstation, replacing all duplicate files. 

8. Return to the \Bin\MCM directory in your workstation's Counterpoint directory, extract the 
MCM_DLL_EMV_Std_Call_4_2_16_build183.zip file to a temporary directory, and then copy the contents of that directory to the 
C:\MerchantConnectMulti directory, replacing all duplicate files. 

9.  Copy the \cctag_paymentech_Radiant_442 file in the \Bin\MCM directory in your workstation's Counterpoint directory to the 
C:\MerchantConnectMulti directory. 

 Repeat these steps on each workstation to which you are going to connect an Ingenico iPP320 SPED. 

Configuring an Ingenico iPP320 SPED 
Follow these steps to configure an Ingenico iPP320 SPED for use with Chase Paymentech Canada: 

1. Connect the iPP320 SPED to your workstation. 

2. Select Setup > Point of Sale > Devices from the Counterpoint main menu to display the Device Management window. 

 Your store and workstation(s) must be configured to use the Device Management framework. 

3. In the Stores and Workstations tree, expand your store, click the workstation to which the iPP320 SPED is connected, and click the 
Add a Device button. 

4. Select PinPads and select Tender Retail Secure PIN Entry Device. 

5. Select the device from the Stores and Workstations tree to display the Workstation Device settings. 

 

6. Enter a Description for the device. 
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7. Click the Config button to display the CCTAG File Maintenance window. 

 

8. On the General Data tab, enter a Client Terminal ID for the workstation. 

 Each workstation must have a unique Client Terminal ID value between 1 and 99. 

9. In the Merchant & Vendor ID field, enter the Merchant ID and Vendor ID values provided to you by Chase Paymentech Canada, 
followed by the value 005E, separated by semicolons (e.g., 700000000000;1234;005E) 

10. Enter the Username and Password provided to you by Chase Paymentech Canada. 

11. Click the Devices tab and make sure the Ingenico PINSmart (Canadian Debit) option is selected in the PIN Pad list box. 
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12. Enter the COM port to which the iPP320 is connected in the PINPad Port field. 

13. Make sure the Wait for POS ACK PINPad Display Delay check box is selected. 

14. Make sure the Automatic Initialization check box is selected. 

15. Click the Card Types tab and select the check box for each card type your store accepts under Accepted Card Types. 

 

16. Under Transaction Limit Options, select the Enable QPS Signature and Enable RFID Signature check boxes if you require 
signatures for swiped cards and EMV (i.e., Chip and PIN) cards, respectively. 

17. Under Supported EMV Applications, select the check box for each card type for which you accept EMV cards. 

18. Select Save from the File menu to save your changes. 

19. Close the CCTAG File Maintenance window to return to the Device Management window. 

 Repeat steps 3 through 19 for each workstation to which an iPP320 SPED is connected. 

20. Click the Save & Close button on the Device Management window. 

Configuring Form Groups for Use with Chase Paymentech Canada 
Once you have configured your iPP320 SPEDs, use the Form Groups window (Setup > Point of Sale > Form Groups) to update your 
TICKET form group to include the TRSalesDraft1English.rdlc, TRReceipt1English.rdlc, TRSalesDraft1French.rdlc, and 
TRReceipt1French.rdlc forms. 

You should also update the CDFAILPMT form group to include the TRSalesDraft1English.rdlc and TRSalesDraft1French.rdlc forms. 
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Ingenico iSC250 P2PE Manual Credit Card Entry 
If you are using an Ingenico iSC250 payment terminal with NCR Secure Pay, you can configure NCR Counterpoint to support manually-
entered credit and debit card transactions through NCR Secure Pay when point-to-point encryption (P2PE) is enabled. 

Once you have completed the steps outlined below, you will be able to use your Ingenico iSC250 payment terminal(s) to enter P2PE-
compliant credit card data when a card is unreadable or unavailable for any reason. For example, customers can enter card data manually to 
complete payments at the point of sale. In addition, you can manually enter "card on file" data to associate with your customer records. 

 Counterpoint does not support manual entry of gift cards and stored value cards (SVCs) with an iSC250. 

 Your iSC250 payment terminal(s) must be updated to firmware version 12.02 or later and must be configured for use with NCR Secure Pay 
P2PE to support manual entry of credit and debit card transactions. 

Configuring P2PE Manual Credit Card Entry 
First, you must configure NCR Counterpoint to use point-to-point encryption only when it is available, which will allow users to enter credit card 
numbers manually when an iSC250 payment terminal is not connected or is otherwise unavailable, and specify whether you want to require 
the entry of a CVV/CID number for each manual transaction. 

Follow these steps to configure Counterpoint to allow the manual entry of credit card numbers when P2PE is not available: 

1. From the main menu, select Setup > Point of Sale > Stores to display the Stores window. 

2. On the Main tab, select Require P2PE When Available from the Required encryption level list box. 

3. Save your changes and close the Stores window. 

4. From the main menu, select Setup > Point of Sale > Devices to display the Device Management window, and then double-click 
your store in the Stores and Workstations tree. 

5. Double-click a workstation to which an iSC250 payment terminal is connected. 

6. Click the Ingenico iSC250 Pay Terminal device entry and select the CVV Required for Manual Entry on Device check box to 
require a CVV/CID number for each credit or debit card number that is entered manually. 

 Repeat steps 5 and 6 for each workstation with an iSC250 payment terminal. 

7. Click Save & Close to save your changes and close the Device Management window. 

Entering Card Data Manually at the Point of Sale 
When you are processing a ticket in Ticket Entry or Touchscreen Ticket Entry, if a customer’s credit card is unreadable, the customer can 
use the iSC250 to manually enter the necessary card data, which will be encrypted and tokenized by NCR Secure Pay. 

Follow these steps if a customer’s credit card is unreadable at the point of sale: 

1. Instruct the customer to tap the Enter Card button on the iSC250 screen. 

2. Instruct the customer to enter his or her card number using the iSC250 keypad, and then press the Enter key. 

3. Instruct the customer to enter the expiration date for the card—in MMYY format—using the iSC250 keypad, and then press the Enter 
key. 

4. Instruct the customer to enter the Card Verification Value/Card Identification (CVV/CID) number for the card using the iSC250 keypad, 
and then press Enter. 

 The customer is prompted for the CVV/CID number only if the CVV Required for Manual Entry on Device check box is selected for the 
iSC250 in Device Management. 

5. Complete the ticket normally. 

 The customer name for manually-entered transactions will be set to ENTERED MANUALLY by default. 
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Entering a Customer Card Manually 
You can use an iSC250 to manually enter a "card on file" for a customer, which will be encrypted and tokenized by NCR Secure Pay. The card 
on file can then be used for future transactions, without requiring the customer to provide the card number again. 

Follow these steps to manually enter a P2PE-compliant “card on file” for a customer: 

1. From the NCR Counterpoint main menu, select Customers > Customers to display the Customers window. 

2. Enter or look up the customer for whom you want to enter a "card on file." 

3. Tap the Enter Card button on the iSC250 screen. 

4. Enter the customer’s card number using the iSC250 keypad, and then press the Enter key. 

5. Enter the expiration date for the card—in MMYY format—using the iSC250 keypad, and the press the Enter key. 

6. Enter the Card Verification Value/Card Identification (CVV/CID) number for the card using the iSC250 keypad, and then press Enter. 

 The customer is prompted for the CVV/CID number only if the CVV Required for Manual Entry on Device check box is selected for the 
iSC250 in Device Management. 

7. Select the Payment tab on the Customers window. 

8. In the Credit Cards section, enter or look up the appropriate Card pay code. 

9. Save your changes and close the Customers window. 

 The customer name for manually-entered card on file transactions will be set to ENTERED MANUALLY by default. 

MasterCard Terminal Identification Compliance 
To ensure compliance with MasterCard terminal identification requirements, each credit card transaction processed for Retail merchants 
through NCR Secure Pay or NCR Counterpoint Gateway (CPGateway) includes station ID and lane ID values to identify the Counterpoint 
workstation on which the transaction originated. 

No configuration changes are required to enable this enhancement; all transactions automatically include these identifying values. 
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NCR Secure Pay Support 
NCR Counterpoint allows merchants to securely process credit, debit, and gift cards through NCR Secure Pay, which supports point-to-point 
encryption of card data (with optional hardware, available from NCR), enhances security through the tokenization of credit card numbers, and 
offers a Web-based settlement interface. 

Before you can begin using NCR Secure Pay to process transactions, you must sign up for NCR Secure Pay and configure NCR Counterpoint 
to use Secure Pay. You must also configure your network to allow the necessary outbound traffic to NCR Secure Pay servers. You may also 
need to configure your payment terminals and MSRs for use with the Device Management framework to take advantage of point-to-point 
encryption (P2PE). 

Refer to the NCR Secure Pay online help for more information about signing up for and configuring NCR Secure Pay for use with NCR 
Counterpoint. 

NCR Secure Pay and NCR Counterpoint Gateway 
Counterpoint allows you to use NCR Secure Pay and NCR Counterpoint Gateway (CPGateway) at different stores simultaneously. However, 
because encrypted card numbers are not stored in the Counterpoint database for stores that are using NCR Secure Pay, stores that are 
configured to use CPGateway cannot access payment data for transactions that originated in NCR Secure Pay stores. 

This limitation imposes certain restrictions on how NCR Secure Pay stores and CPGateway stores can interact. Specifically, you cannot 
perform the following actions at a store that is configured to use CPGateway: 

• Automatically process a validated return for a ticket with a credit card payment that originated at an NCR Secure Pay store. 

 To complete a validated return at a CPGateway store for a sale that originated at an NCR Secure Pay store, you must re-swipe the original 
card or manually enter payment information for the refund. 

• Release an order or layaway for which final payment was specified at an NCR Secure Pay store. 

• Automatically accept a deposit for an order or layaway using the account for which the final payment was specified at an NCR Secure 
Pay store. 

 You can accept a deposit for an order or layaway by re-swiping the original card or manually entering payment information for the deposit. 

• Use credit cards on file for customer records that were created at an NCR Secure Pay store. 

 Payment data for transactions that originated at a CPGateway store can be accessed at NCR Secure Pay stores that share the same 
company database, so these restrictions do not apply to tickets, orders, or layaways created a stores using CPGateway. 

Point-to-point Encryption of Card Data 
When used with a certified magnetic stripe reader (MSR) or payment terminal, NCR Secure Pay and NCR Counterpoint support point-to-point 
encryption (P2PE) of credit card and debit card data. Point-to-point encryption, also known as end-to-end encryption, ensures that card 
numbers, expiration dates, and debit card PINs are encrypted at the point of entry (e.g., the card swipe). Because encrypted card data can 
only be decrypted by NCR Secure Pay, unencrypted card data is never stored or accessible in your Counterpoint environment. 

P2PE requires a certified MSR for the encryption of card swipe data or a certified payment terminal for the encryption of card swipes, 
manually-entered card numbers, and debit card PINs. 

The following MSRs and payment terminals support P2PE with NCR Counterpoint and NCR Secure Pay: 

• MagTek Magnesafe Mini MSR 

• Ingenico iSC250 Payment Terminal 
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Kits/Bills of Material 

Grouped Tag-along Item Kits 
NCR Counterpoint now allows you to define and sell grouped tag-along item kits. As with tag-along item kits, the components of a grouped 
tag-along item kit "tag along" with the parent item when you sell it, but are priced independently of the parent item. Also, you can define 
prompts for each component of a grouped tag-along item kit to allow users to decide, at the time of the sale, whether to add the component to 
the ticket. 

However, the components of a grouped tag-along item kit do not appear as individual lines when they are added to a ticket. Instead, all of the 
kit's components are grouped together below the parent item, allowing you to easily determine which items belong to the kit. 

 

You cannot modify the components of a grouped tag-along item kit or substitute other items for them once they are added to a ticket. 
However, you can remove a component of a grouped tag-along item kit from a ticket if the component is not designated as Required. 

 Deleting a required component of a grouped tag-along item kit from a ticket deletes the entire kit. 

Sales of grouped tag-along item kits are tracked by parent item and by component item, for inclusion on relevant sales reports. Further, 
accounting and cost distributions are generated for the parent item and for all component items of a grouped tag-along item kit. 

 You must purchase and register the Kits/Bills of Material Option to use this feature. 

Defining a grouped tag-along item kit 

Selling a grouped tag-along item kit 
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Defining a Grouped Tag-along Item Kit 
Follow these steps to define a grouped tag-along item kit: 

1. From the main menu, select Inventory > Sales Kits to display the Sales Kits window. 

 
2. Enter or look up the Item number for the kit's parent item. 

Any item can be the parent of a grouped tag-along item kit, regardless of its Item type or Tracking method. 

3. Select Grouped tag-along item from the Kit type list box. 

 The Include parent check box is selected by default and cannot be cleared. This means that the parent item will always appear on the ticket 
when you sell a grouped tag-along item kit. 

4. Enter any remarks you want to make about the kit in the Comments field. 

5. If you would like to display a note or other reminder when the kit is sold, enter the text to display in the Display note field. The 
Display note text appears when a user adds the kit to a line in Ticket Entry or Touchscreen Ticket Entry. 

6. Enter or look up the Item number of a component item you want to include in the kit. 

You can include an item with any Tracking method as a component of a grouped tag-along item kit. If the item you specify is gridded, the 
Grid Dimensions dialog appears, requiring you to specify the grid dimensions of the component. 

 You can change the grid dimensions for a gridded component by clicking the Select Cell button and selecting different dimensions on the 
Grid Dimensions dialog. 

You can also include an item that is the parent of another grouped tag-along item kit, allowing you to embed, or "nest," one grouped tag-along 
item kit inside another. However, you cannot designate the parent of a tag-along item kit or a miscellaneous kit as a component of a grouped 
tag-along item kit. 

7. Enter the Quantity of the component to add to the ticket for each parent item sold, and then select the Unit for the component item. 

8. Click the Is Return Line button if you want the component to appear as a return line when you sell the kit, changing its quantity to a 
negative value. 

 Refer to Including Return Lines in Tag-along Kits for more information about the Is Return Line setting. 

9. Select the Required check box to indicate that the component must be included with the kit. If you remove (i.e., delete) a component 
with this setting from a ticket, the entire kit is removed. 

10. To define a confirmation prompt for the component, enter the prompt text in the Component prompt field. 
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When a user adds the kit's parent item to a ticket, this text appears in a confirmation dialog, allowing the user to decide whether to add the 
component to the ticket. Components without a Component prompt are automatically added to the ticket when a user sells the parent item. 

 Repeat steps 6 through 10 for each component you want to add to the kit. 

11. If necessary, select each component and use the Move up and Move down buttons to change the order of the component items. The 
order in which the components appear is the order in which they will appear on the ticket when the kit is sold. 

12. When you have finished adding components to the grouped tag-along item kit, click the  button to save your changes. 

Selling a Grouped Tag-along Item Kit 
To sell a grouped tag-along item kit in Ticket Entry or Touchscreen Ticket Entry, enter or look up the Item number of its parent item. 

 
When you sell a grouped tag-along item, a confirmation dialog appears for each component with a Component prompt value. Click Yes to 
add the component item to the ticket, No to skip the component, No to all to skip all components with prompts, or Yes to all to add all 
components with prompts. 

 
The parent item is added to the ticket automatically, along with each component item for which no Component prompt value is defined. 

If a Display note is defined for the kit, it appears in an Information dialog after all of the component items have been added to the ticket. Click 
OK to close the display note. 
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Removing a component from a grouped tag-along item kit 
You cannot modify or substitute components of a grouped tag-along item kit. However, you can remove a component by clicking the 
component item and selecting Delete line from the Line menu. 

If the component is required (i.e., the Required check box is selected for the component), the entire kit is removed from the ticket when you 
delete the component. 

Grouped tag-along kits on receipts 
When you print a receipt that includes a grouped tag-along item kit, the parent item appears on the receipt, followed by each component item, 
as illustrated in this sample receipt. 
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Including Non-inventory and Service Items in Bills of Material 
You can now include Non-inventory and Service items in bills of material and quick assembly transactions. This enhancement allows you to 
easily add labor, service charges, assembly materials (e.g., nuts, bolts, glue, or packaging), or other miscellaneous items to a bill of material 
and include their cost in the assembly of finished goods. 

To add a Non-inventory or Service item to the list of components in a bill of material, enter or look up its Item number on the on the Bills of 
Material window (Inventory > Bills of Material), and then enter the default Quantity of the component that is required to assemble of unit of 
the parent item. 

 

 Just like any other component, you can allow users to change the default quantity for the component during assembly by selecting the Allow 
qty change check box. 
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When you use the Quick Assemblies window (Inventory > Quick Assemblies > Enter) to create a quick assembly transaction, any Non-
inventory and Service items in the bill of material you select are included automatically, along with the other components of the finished 
good. 

 
 You can use the Column designer to add the Item type and Unit cost columns to the component table on the Quick Assemblies window. 

By default, Counterpoint uses the Standard cost specified on the Inventory window (Inventory > Inventory) as the Unit cost for Non-
inventory and Service items. However, if the Standard cost is 0 (or NULL) for a Non-inventory or Service item, Counterpoint uses the 
corresponding COS% value to calculate the Unit cost of the component as a percentage of the price of the finished good. 
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The total cost of all Non-inventory and Service components is included in the B/S inventory account distributions that are created when you 
post a quick assembly transaction. In addition, Counterpoint creates a balancing distribution in the Misc item expense account for the total 
cost of all Non-inventory and Service components. 

 The cost of Non-inventory and Service items cannot be displayed on the Quick Assembly Edit List (Inventory > Quick Assemblies > Edit 
List) and won't be included in the Estimated unit cost of the finished good. 

 

Including Return Lines in Tag-along Kits 
NCR Counterpoint now allows you to include return lines in tag-along item kits and grouped tag-along item kits. 

For example, an auto parts dealer that levies a "core charge" as part of a car battery kit could include an optional return line to refund the core 
charge for customers who exchange their old batteries. 

To designate a component of a tag-along item kit or grouped tag-along item kit as a return line, select the component item and click the Is 
Return Line button on the Sales Kits window (Inventory > Sales Kits). The component's Quantity changes to a negative value and is 
highlighted in red to indicate that the component represents a return line. 

 
To make the return line optional, enter an appropriate confirmation prompt in the Component prompt field. 

  

When you sell a tag-along item kit or grouped tag-along item kit that includes a return line component in Ticket Entry or Touchscreen Ticket 
Entry, the component is added to the ticket as a Return line. 

 

 If you return the parent item of a kit that includes a return line component, that component is added to the ticket as a Sale line. 
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Using Field Names in Kit Component Prompts 
You can now include field names from the VI_INV_PRC view in component prompts for tag-along item kits and grouped tag-along item kits. 
This feature allows you to display the field's current value in the confirmation dialog for a kit component. 

For example, you could include the INV_PRC_1 field in a component prompt to display the component's current price when a user sells the 
kit's parent item, or the QTY_AVAIL field to indicate how many of the component are left. 

To insert a field name in a component prompt, enter %[FIELDNAME] in the Component prompt field, where FIELDNAME is the name of the 
field. 

 
 To see all of the field names that are available for use in kit component prompts, open the VI_INV_PRC view in the SQL Script Utility or 

another SQL editor. 

You can also include \n in a Component prompt value to insert a line break in the confirmation prompt text. 

 
  

When Counterpoint displays the confirmation dialog for a component, the current value of each included field appears in place of the specified 
field name. 
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Multi-Site Option 

Autosubscribe Removed from Multi-Site Configuration Editor 
In this version of NCR Counterpoint, the Autosubscribe check box has been removed from the Subscriptions tab of the Multi-Site 
Configuration Editor utility (Start > Programs > NCR Counterpoint > Utilities > Multi-Site > Multi-Site Configuration Editor). 
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Offline Ticket Entry Option 

Compression of DataSync Packages 
In this version of NCR Counterpoint, all DataSync packages—including full extracts, incremental extracts, and rebuilds—are compressed on 
the server before being transferred to an offline workstation, and then expanded on the workstation before being applied to the offline 
database. This enhancement conserves network bandwidth, particularly in Offline Ticket Entry environments with a large number of offline 
workstations. 

Rebuilding Multiple Offline Workstations Simultaneously 
By default, when you use the NCR Counterpoint Management Console (Start > NCR Counterpoint > Utilities > Management Console) to 
start the rebuild process for multiple offline workstations, the database initialization package is downloaded to each workstation in turn. In this 
version, you can configure CPServices to download the database initialization package to multiple workstations simultaneously, reducing the 
time required to rebuild multiple offline workstations considerably, particularly in large Offline Ticket Entry environments. 

Follow these steps to allow multiple offline workstations to be rebuilt simultaneously: 

1.  Open the CpSvcs.exe.config file in the \Bin subdirectory of your Counterpoint installation directory (e.g., C:\Program Files\Radiant 
Systems\Counterpoint\CPSQL.1\Bin). 

2. Find the following entry in the <appSettings> section: 

<add key="ConcurrentRebuilds" value="1" /> 

3. Change the value to the number of station rebuilds you want to allow your Counterpoint server to process simultaneously. For 
example, to allow three workstations to be rebuilt simultaneously, change the value to "3" (as indicated below). 

<add key="ConcurrentRebuilds" value="3" /> 

The number of workstations that can actually be rebuilt simultaneously will be limited by your server's available bandwidth. 

4. Save your changes and restart CPServices on your server. 
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Ingenico iSC250 Signature Threshold 
In this version of NCR Counterpoint, you can define a signature threshold for your iSC250 payment terminal(s), which specifies the minimum 
dollar amount for which your store requires a signature. With this setting, customers will be prompted to provide a signature on the iSC250 
only if the total amount due for a ticket equals or exceeds the signature threshold you specified. 

 This feature is only supported with Ingenico iSC250 payment terminals; signatures threshold cannot be defined for other payment terminals. 

Follow these steps to define a signature threshold for an iSC250 payment terminal: 

1. Select Setup > Point of Sale > Devices to display the Device Management window. 

2. In the Stores and Workstations tree, select your store, and then select the workstation to which the iSC250 is connected. 

3. Select the Ingenico iSC250 Payment Terminal device to display the device settings in the Workstation Device area of the Device 
Management window. 

4. Enter the signature threshold for the iSC250 in the Amount Required for Signature Capture field. 

 

5. Click the Save button to save your changes. 

 Repeat steps 2 through 5 for each of your iSC250 payment terminals. 

In Ticket Entry or Touchscreen Ticket Entry, if the total amount due for a ticket is lower than the Amount Required for Signature Capture 
value you defined, the customer will not be prompted for a signature on the iSC250. 
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Customization 

Default Image Format for Custom Image Fields 
Previously, when you selected an image for a custom image field in NCR Counterpoint, the Open dialog box automatically filtered the 
available images to bitmap (.bmp) files only. If the image you wanted to select was a different file type, you were required to select the 
appropriate format from the Files of type list box. 

In this version, the default Files of type setting for custom image fields has been changed to All, allowing you to easily browse images in all 
supported formats, including bitmap (.bmp and .dib), JPEG (.jpg, .jpeg, and .jpe), and Portable Network Graphics (.png) files. 

New Custom Stored Procedure Calls 
This version of NCR Counterpoint includes new stored procedure calls that allow you to trigger custom stored procedures to apply database 
functions or perform special actions before or after specific events. 

Counterpoint calls the BEFORE_PS_TE_DELETE_DOC stored procedure, if you have defined one, immediately before a ticket, order, hold, 
quote, or other Point of Sale document is deleted from the database. Counterpoint also calls the AFTER_PS_TE_DELETE_DOC stored 
procedure immediately after a Point of Sale document is deleted from the database. 

In addition, Counterpoint now calls the AFTER_PS_TE_SAVE_DOC stored procedure, if one has been defined, immediately after a ticket or 
other Point of Sale document is saved, instead of the USER_AFTER_PS_TE_SAVE_DOC stored procedure. Similarly, Counterpoint now calls 
the AFTER_PS_TE_VOID_DOC stored procedure immediately after a ticket or other Point of Sale document is voided, instead of the 
USER_AFTER_PS_TE_VOID_DOC stored procedure. 

 If you are updating from a previous version of NCR Counterpoint and you have been using custom USER_AFTER_PS_TE_SAVE_DOC or 
USER_AFTER_PS_TE_VOID_DOC stored procedures, you must change their names to AFTER_PS_TE_SAVE_DOC and 
AFTER_PS_TE_VOID_DOC, respectively. 

You can disable custom stored procedures by clearing the Enable customizations check box on the User Interface tab of the User 
Preferences window (Setup > System User Preferences). 
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